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1.

Introduction

This guide describes the Elixir Forms Editor Desktop,
the Windows-based operating environment for launching and using Elixir applications such as Elixir Forms
Editor, Elixir AppBuilder for AFP and Elixir AppBuilder
for XGF.
Additionally, the Desktop has numerous productivityenhancing features, including those which enable you
to:
convert files to icons
link files to applications, thereby allowing you to
start an application and load a file in one step
define icons for DOS or Windows-based applications you want to launch from the Desktop, such
as word processors, desktop publishers and
spreadsheets.
Because this guide describes all functions and features of the Desktop, certain options described herein
may not apply to your specific configuration. In such
cases, unavailable options display in gray (not black)
on menus and dialog boxes, and some screens and
icons may not display at all.
See the Elixir Forms Editor Getting Started Guide for
detailed installation information.
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Customer support
Elixir customer support centers provide telephone
technical assistance for Elixir users during business
hours.
If you have purchased your Elixir product directly from
Elixir Technologies then contact one of the support
center hotlines.
See the Elixir Forms Editor Getting Started Guide for
information about contacting your support center.

Elixir training
Elixir Technologies Corporation offers training for the
complete range of our Windows-based family of software products. For more information, contact:
Elixir Learning
(805) 641-5900 ext. 6

Who should use this guide
This guide serves users needing first-time or ongoing
reference information about the Elixir Forms Editor
Desktop.
Users should already be familiar with Microsoft Windows operations, printer and font management operations and PC peripherals, and have access to reference manuals for related PC software and hardware.
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Conventions
This section describes the following:
display conventions
typographical conventions
Display conventions
ElixirForm adheres to Microsoft Windows conventions
for using menus, menu commands, dialog boxes,
command buttons, icons and the mouse. See your
Windows manual for more information.
Many shortcut keys in the new Windows-based product are different from those in previous GEM versions.
This is because the standard Windows oper- ating environment predefines certain functions to keys (for example, <F1> is always used for Help). See the
"Keyboard shortcuts" appendix for a list of keyboard
shortcuts.
Typographical conventions
The following typographical conventions are used
throughout this guide:
Keystrokes are shown enclosed in < > (angle
brackets). For example:
<Enter>.
Key combinations are denoted by a plus sign between keys. For example:
<Shift> + <F1> indicates simultaneously pressing
the <Shift> and <F1> keys.
Menu titles are shown in bold. Menu options are
enclosed in [ ] (square brackets). For example:
Select [New] from the File menu.
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Commands, options, actions and parameters that
require description are shown in bold, followed on
the next line by the description. For example:
Delete
Deletes the selected files.
Steps in a procedure are shown in numbered bold
paragraphs. For example:
1.

At the prompt, enter the file name and
extension.
Comments relating to a step (such as this paragraph) are shown in regular text following the bold
paragraph.
Commands you enter at the DOS prompt display
in larger text. Within DOS commands, variable
names and keys you press are shown in italics.
For example:

CD \ELIXIR <Enter>

On-line Help
Elixir software uses the Microsoft Windows Help program to provide on-line Help for all functions.
For more information about Windows Help, select the
[How to Use Help] option in the Help menu, or see
your Microsoft Windows documentation.
The Help files included with your Elixir software include graphics created using screen drivers with large
fonts. If you use a screen driver with small fonts, the
Help file graphics may not display clearly. For optimum graphics display, use a screen driver with large
fonts.
You can display on-line Help in the following ways:

1-4

ELIXIR TECHNOLOGIES CORPORATION

INTRODUCTION

Bubble Help
Click on an icon with the right mouse button to view its
properties (if applicable) or to display "bubble help."
Bubble help is a short description of the icon function
that displays in a bubble extending from the icon.
Quick Help
Enable the quick function by selecting the quick help
option in the Usage Switches (or Preferences -- for
ElixirImage) dialog box. When you move the screen
pointer over an icon on the screen, a short description
of the icon function displays in the message area of
the screen. During certain operations a message
about the function you are performing also displays in
the message area. To see these operational messages, disable quick help.
Context sensitive Help
To use this function, click on an icon and press <F1>.
If available, the appropriate Help topic displays. If no
specific topic is available, the Help table of contents
displays.
Help menu
Select [Help] from the top pull-down menu and choose
one of the displayed topics.
Dialog box Help
Click on the [Help] button in a dialog box to view an
associated Help topic. Under Windows 95 and Windows NT, right-click on a dialog box option to display
an associated Help topic.
Help pop-ups and jumps
Within Help topic text, words or phrases underlined in
green are pop-ups or jumps. When you click on a
pop-up topic, a box displays within the current Help
topic with additional information. When you click on a
jump, a different, associated Help topic displays.
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Help hypergraphics
Hypergraphics are special graphics within Help files
that contain "hot spots". Hot spots are either pop-up
topics or jumps. Hypergraphics in Elixir Help are most
commonly dialog boxes with option hot spots (pop-up
definitions), toolboxes with tool hot spots (topic
jumps), and menus with option hot spots (topic jumps
or pop-up definitions).
Move the cursor over a hypergraphic until a hand displays, then click on this hot spot to display a pop-up
topic, or a "jump". To close a pop-up topic, click the
mouse button. To return to the original Help topic
from a jump, click on <Back> in the Help file menu.

Organization of this guide
This guide contains the following chapters and
appendices:
Chapter 1, “Introduction,” presents an overview of
Desktop functions, features and documentation.
Chapter 2, “Desktop basics,” describes the layout and
basic operation of the Desktop.
Chapter 3, “Elixir folders,” describes the Elixir directory structure and how to use the Desktop to organize
and manage forms, fonts, images, documents and
jobs.
Chapter 4, “Desktop configuration,” describes how to
customize the Desktop.
Chapter 5, “Additional Desktop features,” describes
further capabilities built into the Desktop.
Chapter 6, “Peripheral devices,” describes how to
configure and use PC diskette drives, scanners and
printers.
Chapter 7, “File conversions,” describes how to perform various file conversions.
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Chapter 8, “Accessing DOS files and applications,”
describes tools that allow you to access DOS and link
DOS files to applications.
Chapter 9, “Standalone utilities,” explains the program
utilities supplied with the Desktop software package.
“Glossary,” provides an alphabetic listing of the terms
and definitions used in this guide.
Appendix A, “Keyboard shortcuts,” describes all Desktop keyboard shortcuts (fast keys).
Appendix B, “Additional files and directories,” explains
the functions and use of related files not described
elsewhere in this guide.
Appendix C, “The Desktop menu bar,” describes operations accessed from Desktop pull-down menus.
Appendix D, "Local Printers," describes Desktop operations related to proof-printing on HP and PostScript
printers.

Starting the Elixir Forms Editor Desktop
To start the Desktop, double-click on the Elixir Forms
Editor Desktop icon in the Program Manager Elixir Applications window.
The Elixir Forms Editor Desktop displays.
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Figure 1-1. Elixir Forms Editor Desktop
An arrow shaped screen pointer also displays.
If you are using a monochrome monitor and have difficulty reading Title bar text, select [Usage Switches]
from the System menu. Then, in the Usage Switches
dialog box, select [Monochrome Monitor].
An Elixir logo may also display at the center of your
screen. The logo disappears when you press a key on
the keyboard or a mouse button.
Note that you cannot move icons on the Desktop.
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Exiting the Elixir Forms Editor Desktop
To exit the Elixir Desktop or any of its associated applications, perform one of the following:
Double-click on the Close button at the top left of
any Elixir application.
Press <Alt> + <F4>.
Press <Alt> + <X>.
Select [Exit] from the File menu.
Click on the [X] at the top right corner of the application window.

Notes and cautions
The following notes and cautions apply to the Elixir
Forms Editor Desktop User Guide, version 3.11.
The ELXWDATA.BAT program expects that the
Windows directory is located at C:\WINDOWS. If
it is not, edit this .BAT file to point to your Windows directory.
Help files include graphics created using screen
drivers with large fonts. If you use a screen driver
with small fonts, Help file graphics may not display clearly. For optimum graphics display, use a
screen driver with large fonts.
Installing a BWCC.DLL file in a directory other
than drive:\WINDOWS\SYSTEM may cause errors when you perform operations such as copying files from the User Files icon to Elixir folders.
Elixir installs a BWCC.DLL file dated 1993 or later
in your drive:\WINDOWS\SYSTEM directory during installation. Other programs may also install
BWCC.DLL files in different directories. Remove
these other versions of the BWCC.DLL file from
your system to prevent errors.
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Elixir tests its software using HP Windows printer
drivers for proof printing. Other printer drivers are
not supported and may produce unpredictable results when used with Elixir software.
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Desktop basics

This chapter describes the Elixir Forms Editor Desktop layout and basic operation. Later chapters describe more advanced Desktop operations.

Common Windows operating system
The Elixir Forms Editor Desktop uses the standard
Windows interface for display and use of operational
elements such as icons, command buttons, tools,
menus, dialog boxes and mouse.
See your Windows manual for complete information.

Desktop layout
The Elixir Forms Editor Desktop comprises two main
display areas:
The top of the Desktop displays the menu bar and
message area.
The remaining Desktop area displays icons.
Both menu bar and icons provide access to pull-down
menus. See the "Sub-window menus" section in this
chapter, and the "Desktop configuration" and "Additional Desktop features" chapters for more information.
The message area displays information about the operation in process, including relevant error messages.
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Message area

Menu bar

Figure 2-1. Desktop layout

Icons
Each Desktop icon represents an application, folder,
utility or PC device configured for your system. Generally, the name, shape and appearance of an icon indicate its purpose or the type of action you can perform.
The following sections briefly describe each icon and,
where applicable, refer you to chapters where you can
find more information.
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Elixir folder icons
The five icons displayed at the top left of the Desktop
represent specific DOS directories. You can access
directory files and convert them from one format to
another using these icons.
See the "Additional Desktop features", “Elixir folders”
and "File conversions" chapters for more information.
Forms folder
Represents the drive:\ELIXIR\FORMS directory containing Elixir, Input and Output form files.
Fonts folder
Represents the drive:\ELIXIR\FONTS directory containing Elixir, Input and Output font files.
Graphics folder
Represents the drive:\ELIXIR\PICS directory containing Elixir, Input and Output image files.
Documents folder
Represents the drive:\ELIXIR\DOCS directory containing form list files referencing the Elixir-format files for
multi-page documents.
Note that Documents folder functionality for .XGF or
.PDF files requires XGF/PDF option products.
Jobs folder
Represents the drive:\ELIXIR\JOBS\XGFOUT directory containing JDT (Job Descriptor Ticket) files for
transfer to an output XGF printer.
Clipboard icon
Temporarily stores Elixir-format (.ELX) form files during job creation. You can copy an Elixir-format form to
the Clipboard using standard copying procedures,
then copy the form to a specific job when you need it.
ELIXIR FORMS EDITOR DESKTOP USER GUIDE
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User Files icon
Provides access to all DOS directories and files, and
links applications to files. See the "Additional Desktop
features" and “Accessing DOS files and applications”
chapters for more information.
ElixirForm application icon
Represents the Elixir Forms Editor (or Elixir Forms
Editor for Highlight Color if you installed either the
Highlight Option or Plus).
Opening this icon clears the Desktop and starts the
Elixir Forms Editor application. You can also press
<CTRL> and click the right mouse button on this icon
to display icons for launching other installed form
building products.
Other Elixir application icons
If other Elixir applications such as ElixirFont or ElixirImage are installed, icons representing these applications also display at the right of the Desktop. Opening these icons starts the corresponding application.
User Tools icon
Allows you to create and define icons for DOS applications and batch files so that opening the icon starts
the application.
See the "Additional Desktop features" and “Accessing
DOS files and applications” chapters for more information.
Diskette icon
Allows you to access and format a diskette in your PC
disk drive.
See the “Additional Desktop features” and “Peripheral
devices” chapters for more information.
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Printers icon
Allows you to access a local proof printer connected to
your PC.
See the "Additional Desktop features" chapter and
"Local Printers" appendix for more information.
Scanners icon
Allows you to start a scanner connected to your PC directly from the Desktop.
See the "Additional Desktop features" and "Peripheral
devices" chapters for more information.
Dispatcher icon
Allows you to invoke DOS commands or batch files in
which you can embed replaceable parameters.
See the "Additional Desktop features" and “Accessing
DOS files and applications” chapters for more
information.
Converter icon
Allows you to convert form, font and graphics files and
multi-page documents to different formats by using
simple “drag-and-drop” mouse operations.
See the "Additional Desktop features" and “File conversions“ chapters for more information.
Trashbin icon
Allows you to delete folders and files associated with a
specific directory or application.
See the “Deleting files and folders” section for more
information.
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Viewer icon
Allows you to view Elixir-format files associated with
an application without having to first launch the application.
See the "Additional Desktop features" chapter for
more information.

Sub-window menus
The Elixir Desktop offers additional functionality to
normal Windows operations by providing pull-down
menus in sub-windows (or "child" windows) that you
can access from any Elixir folder icon. The following
sections describe these functions.
Backup button
You can access the backup button by first opening
any Elixir folder on the Desktop (Jobs, Forms, Fonts,
Graphics or Documents), then opening any Elixir, Input or Output folder.
Each click on the backup button (or <Ctrl>+<B>) displays the contents of a directory one level closer to the
root.
You can also use the backup button to change the default directory of an Elixir, Input or Output folder in the
SYSTEM.INI file, as follows:
Select [Save Settings on Exit] in the Usage
Switches dialog box (System menu).
Use the backup button to change to the directory
you want as the default.
Exit/close the folder.
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Figure 2-2. Backup button
Filter menu
The Filter menu allows you to display files you select
using the * and ? DOS wildcard characters.

Figure 2-3. Filter menu
For example, in the previous window, you can enter a
filter to display files that start with X as follows:
1.

Select [Enter Filter] from the Filter menu.

2.

In the File Name Entry dialog box (shown
below), type X*.*

3.

Click on [OK] or press <Enter>.
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The window displays only those files beginning
with the letter X.
4.

To turn off the filter, select [Turn Off Filter] in
the Filter menu.

Figure 2-4. File Name Entry dialog box
Selection menu
The Selection menu allows you to select and deselect one or more specified files within a folder. The
following figure shows a Selection menu example.

Figure 2-5. Selection menu
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The Selection menu contains the following options:
Wildcard Selection
Highlight files specified with * and ? DOS wildcard
characters.
Write Selection <Ctrl>+<W>
"Remember” a number of selected files (see the Reselect option, below).
Reselect <Ctrl>+<R>
Highlight files “remembered” using [Write Selection].
When you use [Write Selection] for files accessed
from a Desktop folder (Jobs, Forms, Fonts, Graphics
or Documents) icon, use [Reselect] to highlight files
with the same stem name (and the same or different
extensions) in another folder.
Select All <Ctrl>+<A>
Highlight all files in a window.
Unselect All <Ctrl>+<A>
Deselect all highlighted files in a window.
Make Pubfile
Copy highlighted drive:\ELIXIR\FORMS\ELIXIR and
subordinate directory form files to a diskette. See the
"Additional Desktop features" chapter for more
information.
Archive Pubfile
See [Make Pubfile], above.
View menu
The following figure shows the View menu and an example of viewing files using the [Show Actual] option.
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Figure 2-6. Show Actual example
The View menu allows you to display files in a window
in different ways. The available options are:
Short Name
Display files by name only.
Long Name
Display files by name, creation/revision date and size
(in bytes).
Icon
Display files as icons, with names underneath.
Show Actual
Display reduced, bit-mapped screen versions of Elixir
form, font and image files. Allows you to preview files
without invoking the application and loading the file.
Name
Display files alphabetically by file name.
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Type
Display files alphabetically by file type (extension).
Date
Display files by creation/revision date.
Size
Display files by size (in bytes).
Ascending
Display files in ascending order, either by name or
type (alphabetically, with "A" first), by date (chronologically, with oldest date first) or by size (smallest file
first).
Descending
Display files in descending order, either by name or
type (alphabetically, with "A" last), by date (chronologically, with latest date first) or by size (largest file first).

Accessing DOS
The DOS menu allows you to run DOS commands
from the Desktop.
Selecting the [DOS Command] option or pressing
<Ctrl>+<D> displays a dialog box to allow you to enter
any standard DOS command.
Enter a DOS command and select [OK] to display the
Elixir Exec window and execute the DOS command
from either of the following directories:
the \ELIXIR directory, if no windows are open on
the Desktop
the directory corresponding to the window, if a
window is open on the Desktop.
After the DOS command executes, the system
prompts you to enter any key to redisplay the
Desktop.
See the “Accessing DOS files and applications” chapter for additional ways to access DOS.
ELIXIR FORMS EDITOR DESKTOP USER GUIDE
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Exiting the Desktop
You can exit the Desktop in any of the following ways:
Click on the Exit Box at top left of Desktop
Press <Alt>+<F4>
Press <Alt>+<X>
Use the File menu and select [Exit].
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Elixir folders

This chapter describes the Elixir Forms Editor Desktop folder organization. To better understand this
chapter, you should already be familiar with DOS directory structures.

Folders and DOS directories
Directories and subdirectories are structures DOS
uses to store and organize files. Folder icons on the
Forms Editor Desktop represent DOS directories or
subdirectories. Just as a DOS directory contains files
and subdirectories, Desktop folders contain files and
other folders.
Using folder icons is easier than using DOS directories because you can display folder contents as icons
in a window, and copy files from one folder to another
(see the "Desktop basics" chapter in this guide).
The Elixir folder icons shown in the following figure
display at the top left of the Desktop.

Figure 3-1. Elixir folder icons
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Elixir folder icons allow you to use simple mouse operations to:
access and display Elixir-format files
copy Elixir-format files into different folders
convert form, font, image, document and job files
to and from Elixir format.
To the right of the Elixir folder icons, the User Files
icon shown in the following figure displays.

Figure 3-2. User Files icon
The User Files icon allows you to access any file or
directory on your hard disk or diskette drive. See the
“Accessing DOS files and applications” chapter in this
guide for a description of the User Files icon.

Elixir folder structure
This section describes the structure and use of the
five Elixir folder icons.
Most Elixir folder icons contain three subordinate folders labeled Elixir, Input and Output.
For example, when you open the Elixir Forms folder
icon, the following window displays.
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Figure 3-3. Forms Folders window
Similarly, opening the Elixir Fonts, Elixir Graphics and
Elixir Documents folder icons display a window showing subordinate folders called Elixir, Input and Output.
This folder structure allows you to edit or view form,
font, image, document and job files having different
formats, as shown in the following figure.

Figure 3-4. Input, Elixir and Output folders

Each Input folder is similar to an “in basket" containing files you can convert to Elixir format by
copying them to the Converter icon. See the “File
conversions” chapter in this guide for more information.
Each Elixir folder is similar to a “working area”
where you can edit and view converted files.
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Each Output folder is similar to an “out basket”, to
which edited Elixir-format files are written after
you convert them to their original or other nonElixir format by copying them to the Converter
icon. See the “File conversions” chapter in this
guide for more information.
To use Elixir folders for file editing, follow these steps:
1.

Copy a file you want to edit or view to the
appropriate Input folder.

2.

Convert the file to Elixir format as described
in the “File conversions” chapter of this
guide.

3.

Double-click on the converted Elixir-format
file to start the appropriate Elixir application
(such as Elixir Forms Editor) and load the file.

4.

Edit the file using the tools provided by the
Elixir application. After editing, save the file.

5.

Convert the edited Elixir-format file to the
format you want. The converted file writes to
the appropriate Output folder.

6.

Open the Output folder and copy
converted file to the desired location.

the

The “File conversions” chapter in this guide describes
this procedure in more detail.
The following sections describe the different Elixir, Input and Output folders.
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Forms folder
The Desktop Forms folder corresponds to the
drive:\ELIXIR\FORMS directory and contains the Elixir
Forms, Input Forms and Output Forms folders shown
in the following figure.

Figure 3-5. Forms Folders window
Elixir Forms folder
The Elixir Forms folder corresponds to the DOS
drive:\ELIXIR\FORMS\ELIXIR directory and any userdefined subdirectories within the drive:\ELIXIR\
FORMS\ELIXIR directory (such as drive:\ELIXIR\
FORMS\ ELIXIR\ DEMO).
The Elixir Forms folder displays Elixir form files (files
with .ELX name extensions). You can edit any file using ElixirForm by opening (double-clicking on) the file.
The Elixir Forms folder also displays files with .BAK,
.PUB and .INV name extensions, as follows:
.BAK extension files are backup form files that
ElixirForm creates. You can edit .BAK files if you
rename their extensions to .ELX.
.PUB extension files are publication files used for
archiving and copying Elixir form files and all related components (such as fonts and graphics
used on the form) to a diskette. See the “Elixir
Fonts folder” section in this chapter for more
information.
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When you use the ELXINV utility to convert .ELX
files to a different orientation (from portrait to inverse portrait, for example), you create .INV extension files. To edit these files using ElixirForm,
rename the extensions to .ELX. See the “Standalone utilities” chapter for more information about
the ELXINV utility.
Input Forms folder
The Input Forms folder is reserved for future use.
Output Forms folder
The Output Forms folder contains a number of subordinate folders, an example of which shows in the following figure.

Figure 3-6. Forms Output Folders window
When you use the Converter icon to convert files (as
described in the “File conversions” chapter of this
guide), output files write to the Output folders with appropriate file extensions, as shown in the following table.
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Output Forms
folder

DOS subdirectory and file extensions

HP PCL Forms

\ELIXIR\PRINTS\HPPRINT\*.PRN

PostScript Forms

\ELIXIR\FORMS\PSOUT\*.PS

PDF Forms

\ELIXIR\FORMS\PDFOUT\*.*

XGF Forms

\ELIXIR\PRINTS\XGFOUT\*.*

The above Output Forms folders show all formats to
which Elixir Desktop products can be converted.

Fonts folder
The Fonts folder corresponds to the drive:\ELIXIR\
FONTS directory and contains the Elixir Fonts, Input
Fonts and Output Fonts folders as shown in the following figure.

Figure 3-7. Fonts Folders window
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Elixir Fonts folder
The Elixir Fonts folder corresponds to the DOS
drive:\ELIXIR\FONTS\ELIXIR subdirectory and displays Elixir-format font file names with .HDR extensions. You can edit these files using ElixirFont by
opening (double-clicking on) the files. See the ElixirFont User Guide for more information.
Although only .HDR extension files display, each
Elixir-format font consists of three files having the
same stem name but different extension, as follows:
.HDR - the font header file
.GLH - the glyph (character) header file
.GLY - the glyph (character) bitmap file
The .GLH and .GLY files are also in the drive: \ELIXIR\FONTS\ELIXIR subdirectory, but do not display in
the window. You can display all three components if
you open the subdirectory using the User Files icon
described in the “Accessing DOS files and applications” chapter of this guide.
When you copy a font from the Elixir Fonts folder using the Desktop copy operation (copying to a diskette,
for example), all three file components copy.
If you want to copy an Elixir font using either the User
Files icon or DOS COPY command, remember to
copy all three components for each file.
Input Fonts folder
The Input Fonts folder contains subordinate folders,
as shown in the following figure.
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Figure 3-8. Fonts Input Folders window
To prepare a font file for conversion, first copy it to the
appropriate Input Fonts folder. Make sure the file has
the correct name extension for the folder, as shown in
the following table.
Input Fonts folder

DOS subdirectory and file extensions

HP PCL Fonts

\ELIXIR\FONTS\HPIN\*.FNT

Outline Fonts

\ELIXIR\FONTS\CONTOURS\*.TDF
(default - also user-definable)

The above Input Fonts folders show all formats from
which Elixir Desktop products can be converted.
Output Fonts folder
The Output Fonts folder contains a number of subordinate folders, as illustrated below.
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Figure 3-9. Fonts Output Folders window
When you use the Converter icon to convert files (described in the “File conversions” chapter of this guide),
output files write to the Output folders with appropriate
name extensions, as shown in the following table.
Output Fonts folder

DOS subdirectory and file extensions

HP PCL Fonts

\ELIXIR\FONTS\PRINTER\*.FLJ
(regular fonts)
\ELIXIR\FONTS\PRINTER\*.RLJ
(rotated fonts)

Screen Fonts

\ELIXIR\FONTS\SCREEN\DEMO\*.VGA
(VGA monitors)
\ELIXIR\FONTS\SCREEN\DEMO\*.FNT
(other monitors)
\ELIXIR\FONTS\SCREEN\DEMO\*.WDT
(width tables)

Windows

\ELIXIR\FONTS\SCREEN\WINDOWS\*.*

The above Output Fonts folders show all formats to
which Elixir Desktop products can be converted.

Graphics folder
The Graphics folder corresponds to the
drive:\ELIXIR\PICS directory and contains the Elixir
Images, Input Images and Output Images folders
shown in the following figure.
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Figure 3-10. Images Folders window
Elixir Images folder
The Elixir Images folder corresponds to the
drive:\ELIXIR\PICS\PRINTER directory and contains
Elixir graphics-format files with .LP3 extensions. You
can edit these files by opening (double-clicking on) the
files. Opening a file starts ElixirGraphics and loads the
file.
Input Images folder
The Input Images folder contains a number of subordinate folders, as shown in the following figure.

Figure 3-11. Images Input Folders window
To prepare a graphics file for conversion, first copy it
to the appropriate Input Images folder. Make sure the
file has the correct name extension for the folder, as
shown in the following table.
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Input Images folder

DOS subdirectory and file extensions

PCX Pics

\ELIXIR\PICS\PCXIN\*.PCX

TIFF Pics

\ELIXIR\PICS\TIFFIN\*.TIF

BMP Pics

\ELIXIR\PICS\BMPIN\*.BMP

The above Input Images folders show all formats from
which Elixir Desktop products can be converted.
Output Images folder
The Output Images folder contains a number of subordinate folders, as shown in the following figure.

Figure 3-12. Images Output Folders window
When you use the Converter icon to convert files (described in the “File conversions” chapter of this guide),
output files write to the appropriate Output folders with
appropriate file extensions, as shown in the following
table.

3-12

ELIXIR TECHNOLOGIES CORPORATION

ELIXIR FOLDERS

Output Images folder

DOS subdirectory and file extensions

PCX Pics

\ELIXIR\PICS\PCXOUT\*.PCX

TIFF Pics

\ELIXIR\PICS\TIFFOUT\*.TIF

BMP Pics

\ELIXIR\PICS\BMPOUT\*.BMP

Screen Pics

\ELIXIR\PICS\SCREEN\*.LW8

The above Output Images folders show all formats to
which Elixir Desktop products can be converted.

Documents folder
The Documents folder corresponds to the DOS
drive:\ELIXIR\DOCS directory and contains subordinate Elixir Document, Input Document and Output
Document folders, as illustrated in the following figure.

Figure 3-13. Documents Folders window
Elixir Documents folder
The Elixir Documents folder corresponds to the
drive:\ELIXIR\DOCS\DOCLIST subdirectory and contains form list files.
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A form list file is a .DAT file you create for proof printing using an ASCII editor, containing a list of Elixir
(.ELX) form files for a multi-page document. See the
“Local Printers” appendix of this guide for more information about creating, viewing and proof printing
.DAT files.
Input Documents folder
The Input Documents folder is reserved for future use.
Output Documents folder
The Output Documents folder contains a number of
subordinate folders, as illustrated in the following
figure.

Figure 3-14. Documents Output Folders window
Note that the PDF and XGF Docs output folders display only if their respective extended converters have
been installed.
When you use the Converter to convert files (as described in the “File conversions” chapter of this guide),
output files write to an Output folder with the appropriate file extension, as shown in the following table.
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Output Documents folder

DOS subdirectory

HP PCL Docs

\ELIXIR\DOCS\HPOUT\*.*

PostScript Docs

\ELIXIR\DOCS\PDFOUT\*.*

PDF Docs

\ELIXIR\DOCS\PDFOUT\*.*

XGF Docs

\ELIXIR\DOCS\XGFOUT\*.*

The above Output Documents folders show all formats to which Elixir Desktop products can be
converted.

Jobs folder
The Jobs folder corresponds to the drive:\ELIXIR\
JOBS\XGFOUT directory and contains Job Descriptor
Ticket (JDT) files ready to be transferred to the XGF
printer.

Figure 3-15. Jobs folder
Elixir Docs Jobs
The Elixir Docs Jobs folder corresponds to the
drive:\ELIXIR\DOCS\DOCLIST directory and displays
a list of Elixir jobs (.DAT files). Each Elixir job is an
ASCII file that contains a list of Elixir form files and
print ticket information for the individual form files.
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Elixir Data Jobs
The Elixir Data Jobs folder displays files in the
drive:\ELIXIR\JOBS\ELIXIR\SYSTEM directory.
These are job files created using Elixir AppBuilder.
Note that the DOS file names in drive:\ELIXIR\JOBS\
ELIXIR\SYSTEM are not the same as those in the
Elixir Data Jobs folder; rather, the displayed names
are extracted from the DOS files.
See the Elixir AppBuilder for AFP User Guide for more
information.
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Desktop configuration

To customize your Elixir Desktop, use the options in
the System menu and some of the options in the
Special menu (both of which you access from the
menu bar, shown in the following figure). You can
also access some options using the shortcut keys displayed to the right of menu options.

Figure 4-1. Desktop menu bar
The System menu contains the options shown in the
following figure.

Figure 4-2. System menu
Each option in the System menu allows you to perform certain configuration actions as described below.
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System Config <Alt> + <F6>
Configures basic system parameters.
Usage Switches
Enables and disables some Desktop functions.
User Privileges
Allows you to set up user access controls.
Diagnostics <Alt> + <F5>
Displays diagnostics information and allows you to access your diagnostic application.
Make Directory <Ctrl> + <M>
Allows you to create a DOS directory
Converter Props
Displays and lets you modify control parameters for
the Converter icon.
Reset to Defaults
Resets all configuration parameters to the default
values.
Refresh
Refreshes the screen display.
Toolset
Selects different Desktop toolsets.

System configuration
The [System Config] option in the System menu (and
the <Alt> + <F6> fast keys) allows you to set system
configuration parameters. The Desktop Basic Setup
dialog box shown in the following figure displays.
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Figure 4-3. Desktop Basic Setup dialog box
The Desktop Basic Setup dialog box contains the following options:
Warn on low disk space
Displays a warning if disk space falls below the value
specified in [Threshold]. The default is to not warn.
Threshold
The threshold disk space that triggers a warning to
display — applicable only if you specify Yes for [Warn
on low disk space]. The default is 500 KB, and the
maximum is 25 MB.
Show banner logo file
The .BMP file that displays each time you start the
Desktop, if there are no open windows. The banner
logo may not display correctly if the image is very
large. Initially, the default logo is DESKLOGO.BMP;
you can specify any .BMP file located in
drive:\ELIXIR\PICS\BMPIN.
Show conversion parameters
Displays conversion parameters when converting
files.
Clock Running
Displays the date and time in the menu bar message
area when selected. [Set Time and Date] displays a
dialog box for setting the current date and time.
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Double Click Speed
Sets the speed at which successive mouse clicks interpret as a double-click. The settings are:
[Slowest] (the default)
[Slow]
[Medium] or
[Fast]

Desktop usage switches
The [Usage Switches] option in the System menu allows you to customize the Elixir Desktop. Selecting
this option displays the Usage Switches dialog box, as
shown in the following figure.

Figure 4-4. Usage Switches dialog box
The Usage Switches dialog box contains the following
options:
Confirm file deletions
When deleting one or more files, select to display a
Confirmation for Command dialog box. Otherwise,
deletes the file(s) without requesting confirmation.

4-4

ELIXIR TECHNOLOGIES CORPORATION

DESKTOP CONFIGURATION

Confirm file overwrites
When copying one or more files, if a file with the same
name exists in the target folder, select to display the
Confirmation for Command dialog box. Otherwise
overwrites existing file(s) without requesting confirmation. This option is only applicable when you copy
files through the Desktop.
Show diskette property sheet
Select to display the Diskette Properties dialog box
each time you copy a file to or open the Diskette icon.
See the “Additional Desktop features” and “Peripheral
devices” chapters for more information.
Show printer property sheet
Select to display the Printer Properties dialog box
each time you print a file. See the “Peripheral devices” chapter for more information.
Show scanner property sheet
Select to display the Scanner Properties dialog box
each time you use the Scanners icon. See the “Peripheral devices” chapter for more information.
Save Settings on Exit
Retains the Usage Switches changes you made in the
current Desktop session and displays them in future
sessions.
Monochrome Monitor
Select to execute the DOS MODE MONO command,
required for SIGMA monitors on PS/2 systems, and
for newer (after 1990) SIGMA monitors running in
monochrome (not gray-scale) mode. If you have difficulty reading the title bar text on your monochrome
display, select this option.
Converter
Click on [Converter] to display the Converter Properties Dialog dialog box shown below.
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Figure 4-5. Converter Properties Dialog
dialog box
See the 'File conversions" chapter for more information about the above dialog box and the options described below.
Working Directory
The directory in which temporary read/writes take
place during file conversions. The default is the root
(\). We recommend specifying a RAM disk for faster
conversions.
Confirm file overwrites during conversion
Allows you to specify whether files you create automatically overwrite existing output files with the same
names. Select to display a dialog box requesting confirmation before overwriting an existing file. If you
convert graphics files to .LGO format, the dialog box
also prompts for the orientation. Not selecting this option automatically overwrites existing files. This is applicable only when converting form and .LGO files to
Elixir format.
Show properties before conversions
Allows you to specify default setup options for dialog
boxes for each file conversion type.
Pause after conversions
Select to pause after each conversion.
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Use Elixir HP PCL and PostScript converters
Select to use Elixir's printer drivers when converting
Elixir forms to HP PCL or PostScript formats. If not
selected, you use Windows printer drivers. Elixir
printer drivers produce optimized files that require
substantially less disk space but create identical
printer output as Windows printer drivers.
Stop process after - Error/All files processed.
Specify whether you want conversion to stop after an
error occurs or after file processing.

User privileges
The [User Privileges] option in the System menu,
shown in the following figure, allows you to set the
level of control over certain Desktop operations for the
Elixir Desktop user.

Figure 4-6. User Privileges dialog box
For example, you can choose whether or not to allow
a user to access an Elixir application from the Desktop. If you choose not to allow access, the icons representing the Elixir application and its associated
folder do not display.
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Delete Files
Select to allow setting up the Desktop so users cannot
delete files. Otherwise allows deletions.
Change File Properties
Allows users to change the file name in a Properties
dialog box for a file.
Backup beyond default directories
In the Elixir file structure, select to allow you to back
up directories to the specified drive. When not selected, allows you to back up to the default directory
for the Elixir (Forms, Fonts, Graphics, and Documents) folders only. We recommend NOT selecting
this option.
Access Forms
Allows access to ElixirForm or Elixir-format form files.
The icons representing both do not display on the
Desktop if you do not select this option.
Access Fonts
Allows access to ElixirFont or Elixir-format font files.
The icons representing both do not display on the
Desktop if you do not select this option.
Access Graphics
Allows access to ElixiGraphics or Elixir-format graphics files. The icons representing both do not display
on the Desktop if you do not select this option.
Access Documents
Allows access to non-Elixir files. The User Files icon
does not display on the Desktop if you do not select
this option.
Access Userfiles
Allows access to non-Elixir applications. The User
Files icon does not display on the Desktop if you do
not select this option.
Access UserTools
Allows access to the User Tools icon. The icon does
not display if you do not select this option.
Access Dispatcher
Allows access to the Dispatcher icon. The Dispatcher
icon does not display on the Desktop if you do not select this option.
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Access Transformer
No access effect - the Transformer is not included in
the Elixir Forms Editor product.
Access Converters
Allows access to the Converter icon. The icon does
not display if you do not select this option.
Perform Reset to Default
Select to enable resetting system defaults from the
System menu.
Access DOS
Allows accessing DOS from the Desktop.

Diagnostics
The [Diagnostics] option in the System menu (and the
<Alt> + <F5> fast key) allows you to run a number of
diagnostic utilities and to enter a command to run a
diagnostic program of your choice. Selecting the option displays the Desktop Diagnostics dialog box,
shown in the following figure.

Figure 4-7. Desktop Diagnostics dialog box
Free Memory
Displays available memory in KB.
Free Resources
Displays available
percentage.

Windows
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Base Memory
Displays total base RAM.
Maximum file list
Displays the maximum number of files according to
the size of the window.
Disk Space Left
Shows the disk space left on the hard disk on which
the Elixir Desktop displays.
Current drive
Displays the current drive.
View Install LOG
Click on to display the log file INSTALL.LOG created
when installing Elixir software on your PC. When you
report any problems to the Support Center, the center
may ask for the contents of this log file to help determine the source of your problem.
View AUTOEXEC.BAT
Click on to display the contents
AUTOEXEC.BAT file in a window.

of

the

Show Installed ElixiKeys
Click on to display installed ElixiKeys on your PC.
View CONFIG.SYS
Click on to display the contents of the CONFIG.SYS
file in a window.

Creating a directory
The [Make Directory] option in the System menu allows you to create a directory in a path you enter. Selecting this option or pressing <Ctrl> + <M> displays
the Enter Path of Directory to Create dialog box
shown in the following figure.
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Figure 4-8. Enter Path of Directory to Create
dialog box
Enter the name and path of any directory you want to
create, then click on [OK] to create the directory.
If you do not enter a full path for a directory name:
If a window is open, the directory you enter subordinates to the directory corresponding to the
window.
If the Desktop does not display any open windows, the directory subordinates to the root directory, on the drive where Elixir software loads.

Converter properties
The [Converter Props] option in the System menu
opens the Converters Properties dialog box and allows you to specify certain initial setup options for converting files.

Figure 4-9. Converters Properties dialog box
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Clicking on each option displays the appropriate dialog box for specifying setup parameters. The "File
conversions" chapter describes these parameters.
Clicking on [Converter Properties] displays the Converter Properties Dialog dialog box described in the
Usage Switches section earlier in this chapter.
Clicking on [Message Reporting] displays the Message Options Dialog dialog box.

Figure 4-10. Message Options Dialog dialog box
Select options to [Show messages after process], or
to write messages to a .LOG file, the stem name of
which you can specify.
You can also specify to append new messages to an
existing .LOG file or to overwrite an existing .LOG file.

Resetting System menu options
The [Reset to Defaults] option displays a dialog box
that allows you to reset (to the initial default values)
the specifications you set in the [System Config],
[User Privileges], and [Diagnostics] options in the System menu.
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Refreshing the screen
If closing a window does not completely remove it or
leaves “snow” on the screen, use the [Refresh] option
in the System menu to refresh the screen.

Selecting toolsets
When more than one Elixir Desktop installs on a PC
drive, you can switch between Desktops using the
[Toolset] option in the System menu.

Figure 4-11. Desktop Toolsets dialog box
Desktops differ in icon appearances and allowed file
conversions, which display in the Converter icon dialog boxes. See the “File conversions” chapter for
more information about file conversions.
Selecting the [ToolSet] option displays the Desktop
Toolsets dialog box shown in the previous figure.
Full HYBRID Desktop
Allows all conversions for all installed Desktop
versions.
AFP Desktop
Displays the AFP Desktop.
AS/400 Desktop
Displays the AS/400 Desktop.
Distributed Desktop
Displays the Elixir Forms Editor Desktop.
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Xerox B & W
Allows all black-and-white Xerox conversions. Primarily for ElixirForm/ElixiSys and ElixiSys for Xerox Distributed Printers users.
Xerox H/L Color and B & W
Displays the Desktop for the Elixir HighLight Option
and Plus products. Allows color and black-and-white
Xerox conversions, if you install both versions (for users running both B&W and color monitors and Xerox
4850 and other printers).
Xerox Distributed Printers
Displays the 4235 XES Desktop.

4-14

ELIXIR TECHNOLOGIES CORPORATION

5.

Additional Desktop
features

This chapter describes additional operations you can
perform using the Desktop icons and menu bar File,
System and Special menus. You can perform most
of these operations using keyboard shortcuts, as described in the "Keyboard shortcuts" appendix.
The following figure shows the Desktop menu bar.

Figure 5-1. Desktop menu bar
Operations described in this chapter include:
opening icons
setting icon properties
displaying/deleting different formats of a file
displaying a logo at start-up
copying files
using the Scheduler Desktop
viewing files.
If you are just starting to use the Desktop, you may
want to read the “Desktop basics” chapter first to become more familiar with general Desktop operations.

Opening icons
Opening an icon typically starts a corresponding application or causes a window or dialog box to display
showing properties related to the icon. In most cases,
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you can modify the properties displayed to affect the
performance of the object represented by the icon.
You can open an icon in any of the following ways:
Double-click on it
Click on it and press <Enter>
Click on it and select [Open] from the File menu.
The following sections describe the results of opening
various icons.
Opening a folder icon
When you open a (Forms, Fonts, Graphics, Documents or Jobs) folder icon, a window showing the contents of the folder displays. Each folder typically
comprises one or more sub-folders containing files.
Note that each folder corresponds to a DOS directory.
Opening Elixir files
Elixir files are generic Elixir-format files that you access from the Desktop Elixir folders, and include:
Elixir-format form files in the Elixir Forms folder
(drive:\ELIXIR\FORMS)
Elixir-format font files in the Elixir Fonts folder
(drive:\ELIXIR\FONTS)
Elixir-format graphics files in the Elixir Graphics
folder (drive:\ELIXIR\PICS)
Elixir-format document files in the Elixir Documents folder (drive:\ELIXIR\DOCS).
When you open an Elixir file, the corresponding Elixir
application starts and the file loads in the application.
For example, when you open an Elixir form file, the
Elixir Forms Editor application starts, and the form file
loads (displays on the screen), ready for editing.
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Note that your PC must have the corresponding application installed and enabled. Elixir applications can be
enabled/disabled using the System menu, as described in the “Desktop configuration” chapter.
Note also that you cannot open an Elixir document
icon in the Elixir Docs folder (drive:\ELIXIR\DOCS).
Opening the ElixirForm icon
Opening the ElixirForm icon at the right of the Desktop
starts the ElixirForm application. When you exit the
application, the Desktop redisplays.
Note that pressing <CTRL> and clicking the right
mouse button on the icon instead displays icons representing other installed applications.
Opening device icons
Opening a device icon displays a dialog box for viewing or modifying the current properties of the device
represented, as follows:
Diskette icon
Allows you to access or configure your PC's internal or
external diskette drive. See the "Icon properties" section and “Peripheral devices” chapter for more information.
Printers icon
Allows you to access or configure a local proof printer
connected to your PC. See the "Icon properties" section and "Local Printers" appendix for more information.
Scanners icon
Allows you to access or configure a scanner connected to your PC. See the "Icon properties" section
and “Peripheral devices” chapter for more information.
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Opening other icons
Opening the User Tools, User Files, Dispatcher, Converter and Viewer icons results in different displays, as
follows:
User Tools icon
Displays the User Tools window which allows you to
create an icon for any DOS application or batch file.
See the "Accessing DOS files and applications" chapter for more information.
User Files icon
Displays the User Files: Directory Paths and Tool
Links dialog box which allows you to link files in a window with DOS applications. See the "Accessing DOS
files and applications" chapter for more informa- tion.
Dispatcher icon
Displays the Dispatcher Commands dialog box which
allows you to enter DOS batch commands. See the
"Icon properties" section and “Accessing DOS files
and applications” chapter for more information.
Converter icon
Displays the Converter Properties dialog box which allows you to convert form, font and graphics files to
and from different formats. See the "Icon properties"
section and "Desktop configuration" and "File conversions" chapters for more information.
Viewer icon
Displays the ASCII-based Windows Notepad dialog
box which allows you to view and edit the contents of
an Elixir-format file without launching the associated
application. See the "Viewing files" section for more
information.
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Displaying Icon properties
Using the Desktop, you can view and modify property
specifications for the following:
Converter icon
Dispatcher icon
Viewer icon
device (Diskette, Scanners and Printers) icons
file icons.
To display and modify properties for any of the above,
select the appropriate icon, then perform one of the
following:
Press <F2>.
Press the right mouse button.
Select [Properties] from the File menu.
Files
Selecting [Properties] for a file icon displays the File
Object Properties dialog box shown in the following
figure.

Figure 5-2. File Object Properties dialog box
The File Object Properties dialog box contains the following options:
File name and extension
The name, including any extension, of the selected
file. This is the only option you can change. Enter a
new file name and extension to rename the file.
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File type
The type of file selected; for example, Elixir, HP PCL,
or PostScript.
File size
The size of the selected file in bytes.
Date of last access
The date you created or last changed the file.
Time of last access
The time you last accessed the file.
If you select more than one file, a dialog box for each
subsequent file displays when you click on [OK] or
[Cancel].

Displaying Elixir file formats
When you convert Elixir and Input folders files, files
with the same stem names but different extensions
write to the appropriate Output folders (see the “Elixir
folders' and “File conversions” chapters for more information).
The Desktop file formats feature allows you to select a
file in any Elixir folder, and to display all files with the
same stem name but different extensions on the drive
to which Elixir installs. This feature also allows you to
delete either all or selected file formats from the
directory.
To display different versions of a file, select the desired file from an Elixir folder, then select [Formats]
from the File menu. The File Formats dialog box displays.
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Figure 5-3. File Formats dialog box
The File Formats dialog box displays the different formats of the selected file, and contains the following
options:
No Operation
Perform no operations on displayed files.
Delete * Formats
Delete all displayed formats of a selected file.
Delete * except Elixir
Delete all formats of a selected file, except the Elixir
format.

Displaying a logo
You can configure the Desktop to display a logo upon
start up. However, the logo displays only if you closed
all windows when last exiting the Desktop.
The displayed logo may be any .BMP graphics file in
drive:\ELIXIR\PICS\BMPIN. The default logo is
DESKLOGO.BMP.
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To specify the logo you want displayed, follow these
steps:
1.

Select [System Config] from the System
menu.

2.

In the Desktop Basic Setup dialog box, select
[Show banner logo file].

3.

In the dialog box, specify the stem name of
the .BMP file in the drive:\ELIXIR\PICS\BMPIN
directory you want displayed.

Figure 5-4. Desktop Basic Setup dialog box
Note that, depending on your monitor's screen resolution, the size of the displayed logo changes.

Copying files
Copying files involves different procedures, depending
on whether you are copying files to or from:
Elixir folders
DOS directories on the hard disk
DOS-format diskettes
DOS Elixir-format diskettes
Viewer icon.
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In each case, you select files from a window and then
copy them in one of the following ways:
Drag and drop files on the destination icon.
Press <Ctrl>+<C>, then click on destination icon.
Select [Copy] from the File menu, then click on
the destination icon.
Copying files to Elixir folders
You copy files to Elixir folders when you convert files
to different formats. However, before conversion,
make sure the files have the correct name extensions
for the folders in which they reside. See the “Elixir
folders” chapter for more information.
Copying files to a DOS directory
Tc copy one or more files in a window to another hard
disk directory, select the files and drag and drop them
on the User Files icon. A dialog box similar to the following displays.

Figure 5-5. User Files: Directory Paths and Tool Links
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The dialog box displays the (current) paths you last
specified and allows you to specify up to twelve DOS
directory paths.
To specify the target directory, perform one of the following:
Select any line and type the directory into which
you want to copy files.
When the directory to which you want to copy files
displays, select (highlight) it.
Select any line that shows a path and edit it.
If the directory you enter does not exist, a dialog box
displays requesting confirmation to create a new directory. Select [Yes] to create the new directory. An
empty window for the new directory displays.
Click on [OK] to copy the files. See the “Accessing
DOS files and applications” chapter for more information.
Copying files from a DOS directory
To copy one or more files from a DOS directory, open
the User Files icon to display the User Files: Directory
Paths and Tool Links dialog box.
Enter the name of the directory from which you want
to copy files or, if the path to the directory displays, select it and click on [OK].
A window similar to the following figure displays,
showing the contents of the directory. In the window,
select the files you want to copy, then drag and drop
the files on the Desktop target icon. The target icon
can be any of the Elixir folders, the Diskette icon or
the User Files icon.
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Figure 5-6. Directory window example
Copying files to a DOS-format diskette
To copy selected files from a displayed window to a
DOS-format diskette, first insert a diskette into your
PC disk drive.
Copy the selected files to the Diskette icon on the
Desktop.
The System Diskette dialog box displays.

Figure 5-7. System Diskette dialog box
In the System Diskette dialog box, specify the following options to copy files to a DOS-format diskette:
Directory on Diskette to open
The diskette directory to which you want to write files.
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Diskette Drive
The identifier for your disk drive (normally A or B).
Diskette Type
Select [DOS User-Defined] to copy files to a DOS
directory.
Diskette Access
As appropriate, select either [For WRITing] for a formatted diskette or [Perform FORMAT] to create a
DOS-formatted diskette.
Click on [OK] to copy files.
Copying files from a DOS-format diskette
To copy files from a DOS-format diskette, open the
Diskette icon to display the Diskette Properties dialog
box shown in the figure above.
In the System Diskette dialog box, specify the following options to copy files from a DOS-format diskette:
Directory on Diskette to open
The diskette directory from which you want to copy
files.
Diskette Drive
The identifier for your disk drive (normally A or B).
Diskette Type
Select [DOS User-Defined] to copy files from a DOS
directory.
A window displays showing the contents of the directory you specified. Select the files you want to copy,
then copy the files to a target icon on the Desktop.
Copying files to a DOS-Elixir format diskette
A DOS Elixir-format diskette is a DOS-format diskette
that contains the Elixir file directory structure. You can
copy files such as .PUB files to a DOS Elixir-format
diskette without first creating the destination Elixir directories on the diskette.
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To copy selected files from a displayed window to a
DOS Elixir-format diskette, insert a diskette into your
PC disk drive. If the diskette is not already DOS Elixir
formatted, select the [DOS Elixir] and [Perform FORMAT] options to format the diskette before copying
files.
Copy the selected files to the Diskette icon on the
Desktop.
The System Diskette dialog box displays.

Figure 5-8. System Diskette dialog box
In the System Diskette dialog box, specify the following options to copy files to a DOS Elixir-format
diskette:
Directory on Diskette to open
Select [DOS Elixir] to display the drive:\ELIXIR directory.
Diskette Drive
The identifier for your disk drive (normally A or B).
Diskette Type
Select [DOS Elixir] to copy files to a DOS Elixir-format
diskette.
Diskette Access
As appropriate, select either [For WRITing] for a formatted diskette or [Perform FORMAT] to create a
DOS-formatted diskette with an Elixir directory
structure.
Click on [OK] to copy files.
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Copying files from a DOS Elixir-format diskette
To copy files from a DOS Elixir-format diskette, open
the Diskette icon on the Desktop to display a Diskette
Properties dialog box shown in the figure above.
In the Diskette Properties dialog box, specify the following options to copy files from a DOS Elixir-format
diskette:
Directory on Diskette to open
The drive from which you want to copy files.
Diskette Drive
The identifier for your disk drive (normally A or B).
Diskette Type
To copy files from an Elixir diskette, select [DOS
Elixir].
Diskette Access
Select [for READing]
Click on [OK].
A window displays showing the contents of the directory you specified. Select the files you want to copy,
then copy the files to a target icon on the Desktop.
Copying files from Output to Input folders
To copy one or more files from an Elixir Output folder
to a corresponding Input folder, use the following
procedure.
1.

Open an Elixir folder, then open the Output
folder in the displayed window.

2.

Select the output file(s) you want to copy from
the Output folder.

3.

Copy the file(s) to the destination Elixir icon
on the Desktop.

The selected file(s) copy into the appropriate Input
folder.
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Note that you cannot copy files directly from the Output Documents folder to the Input Documents folder.
Instead, you must copy them to the User Files icon
and, in the displayed User Files: Directory Paths and
Tool Links dialog box, specify the DOS path for the
appropriate Document Input folder.
Note also that you cannot copy files from an Input
folder to an Output folder.
Copying Elixir form files
To copy a form file and all associated elements, use
the Desktop archival feature.
The archival feature allows you to create a publication
(.PUB) file containing references to all font, graphics
and form information for an Elixir-format (.ELX) form
file
in
the
Elixir
Forms
folder
(drive:\ELIXIR\FORMS\ELIXIR).
You cannot use standard DOS or Elixir copy procedures to copy Elixir form files because these files contain elements such as text, fonts and graphics that
reside in different Elixir directories.
Creating a .PUB file
To create a .PUB file for an Elixir form file, follow
these steps:
1.

Open the Elixir Forms folder and select the
.ELX file you want to archive.

2.

From the Selection menu, either select [Make
Pubfile] or press <Ctrl>+<U>. The dialog box
shown in the following figure displays.
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Figure 5-9. Elixir Publication File
dialog box
This dialog box contains the following options:
PubFile name
The name of the .PUB file you want to create, based
on the .ELX file stem name.
Include Screen Fonts
Either select to include, or leave unselected to omit,
screen fonts in the .PUB file.
Include Screen Graphics
Either select to include, or leave unselected to omit,
screen images in the .PUB file.
Include Printer Fonts
Either select to include, or leave unselected to omit,
proof printer fonts (for the proof printer you specify in
the [Proof Printer Fonts for] option) in the .PUB file.
Also includes rotated fonts, if used.
Include Printer Graphics
Either select to include, or leave unselected to omit,
printer images in the .PUB file.
Proof Printer Fonts For
Allows you to specify your proof printer as [HP LJ].
The Elixir Desktop creates a .PUB file in the Elixir
Forms folder with the same stem name as the file you
selected. If a .PUB file with the same name exists in
the Elixir Forms folder, the program prompts you to
confirm overwriting it.
You can view the contents of a .PUB file by doubleclicking on its icon as shown in the following figure.
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Figure 5-10. Publication file components example
Copying a .PUB file to a diskette
To copy a .PUB file to a diskette, follow these steps:
1.

Insert a formatted diskette into your diskette
drive. Open the Diskette icon and make sure
[Diskette Drive] indicates the correct drive.

2.

Select the .PUB file from the Elixir Forms
window.

3.

From the Selection menu, select [Archive
Pubfile].
Alternatively, copy the .PUB file to the Diskette icon.

All directories and related files required for each element of the .PUB file copy to the diskette. If a .PUB
file with the same name exists on the diskette, the
program prompts you to confirm overwriting it. Your
confirmation also overwrites any component files with
the same stem name.
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Restoring a .PUB file from a diskette
To copy a .PUB file and all associated graphics, font
and form files from a diskette to your hard disk, follow
these steps:
1.

Insert the diskette into your diskette drive.

2.

Open the Diskette icon, and select
[DOS-Elixir] to display a window with the
diskette contents.

3.

Display the drive:\ELIXIR\FORMS\ELIXIR (or
subordinate directory) window that contains
the .PUB file.

4.

Copy the .PUB file icon to the Desktop Forms
icon.

5.

Click on the Elixir Forms folder in the
displayed window.

The .PUB file and all associated files copy to the appropriate Elixir folders. If a .PUB file with the same
name exists in the Elixir Forms folder, the program
prompts you to confirm overwriting it. Your confirmation also overwrites any existing component files with
the same stem name.
If you restore a .PUB file to a PC with a different monitor than the PC from which you copied the form file,
your screen fonts and screen graphics may not display correctly. For correct font and graphics display,
use the Converter icon (described in the “File conversions” chapter of this guide) to regenerate the screen
fonts and graphics.
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Using the Elixir Scheduler Desktop
The Elixir Scheduler Desktop allows you to specify
automated file conversions, batch file execution and
other actions, and to specify the conditions for their
performance.
The actions you can specify are:
file conversions
running transcripts
executing an application defined as a User Tool
executing an application defined in the Dispatcher
icon
executing any .BAT, .EXE or .COM command.
The conditions for which you can specify the above
actions are:
the date and/or time for performing an action
checking for the existence of a file before performing an action
performing an action at specified intervals.
Examples of automated actions you can specify with
the Scheduler Desktop are:
If files in an Input Folder are present, convert
them to one or more formats.
At a certain time, perform a certain action (such
as back up files).
(Later, this section provides detailed examples.)
In addition, if you install the Elixir Desktop on a dedicated PC attached to a network, the Scheduler enables uploading files to another destination, for
example, to a high-speed printer.
As an example of a Scheduler setup:
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You can print an application document to a file on
a Network Scheduler.
The Scheduler Desktop detects the file and converts it from its native format to a high speed
printer format.
The Scheduler then automatically sends the file to
the printer for processing.
Scheduler setup
To execute operations from the Scheduler Desktop,
follow these steps:
First, install the Scheduler Desktop on a dedicated PC
attached to the network.
If you want to specify automated file conversions, follow steps 1 through 4. If you want to specify actions
other than file conversions (such as executing batch
files), go to step 5.
1.

Open the User Files icon and specify the
Network Scheduler directory to which the files
print to disk (see the "Accessing DOS files
and
applications"
chapter
for
more
information).

2.

Install the appropriate converter on the
Network Scheduler drive or set its input and
output paths to the Network Scheduler drive.

3.

Right-click on the Dispatcher icon and set up
the Dispatcher to run the files for conversion
through a DOS batch file (see the "Accessing
DOS files and applications" chapter for more
information).

4.

Click on [Setup] in the Dispatcher Commands
dialog box and in the displayed User
Application Setup box, click on [Send only
Filename].

Create the batch file to perform the following:
convert input Dispatcher files to the output format
you previously set up in the Desktop
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write an error log; you can set the Scheduler
desktop to check for the existence of the log and
to pause or to transmit an error message if it exists
send files directly to the printer
delete any unwanted files on the PC.
(Later, this chapter describes more details about
these actions).
5.

Set up the Scheduler Desktop by selecting
[Scheduler Setup] from the Special menu, or
by pressing <Alt> + <F2>

Make the appropriate selections in the Scheduler
Setup dialog box shown in the following figure.

Figure 5-11. Scheduler Setup dialog box
All Scheduler Activity
Sets processing to [Processing] (on) or [OFF] for up to
eight Scheduler actions. [Processing] polls each
Scheduler action to test it for a TRUE, condition. If a
Scheduler action tests TRUE a consequent action
results.
Task Scheduling by
The processing mode. [ID Priority] processes Scheduler actions using number 1 as the highest priority,
and number 8 as the lowest priority. [Circular processing] processes Scheduler actions sequentially
without priority.
Number of allowable scheduler tasks
The number of Scheduler actions tested for when you
select [Processing]. The maximum is eight actions.
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Timing delay between scheduler tasks
The frequency at which the Scheduler tests for TRUE
Scheduler actions, in seconds.
6.

Set up the Scheduler action by selecting
[Scheduler Actions] from the Special menu, or
pressing <Alt> + <F3>.

Figure 5-12. Scheduler Tasks dialog box
Task
Allows definition of up to eight Scheduler actions
(tasks), and to set [Task processing ON] (select) or off
(leave unselected). Click on [Next] or [Prev] to display
and to modify tasks 1 through 8.
Task test
[On File(s)] tests for the existence of a file in a directory, both of which you specify (see next options),
[On DateTime] tests for a specified PC date and time,
[Test TRUE] continually executes the specified action
at the timing interval specified in step 5.
File(s) test Directory
The directory in which the Scheduler checks for the
existence of a file if you select [on File(s)] in Task
test.
Filename(s)
The file for which the Scheduler checks if you selected
[on File(s)] in Task test. DOS wildcards are permissible. [Any] searches for any files in the specified
directory.
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Date
When testing for passage of a specified date, enter
the day, month, and year you want the Scheduler action processed. Select [Any] after the date to process
the Scheduler action every day at the time specified
by Time.
Time
When testing for passage of a specified time, enter
the hours, minutes, and seconds you want the Scheduler action processed.
Action to take
Select [Dispatch] and enter the number of the Dispatcher command to process the Dispatcher command, [Usertool] to process the user tool, or [BATch
File] to process the batch file specified in [Name].
After action
[Delete Files] deletes files after the Scheduler action,
[Task processing OFF] turns processing off after the
action, and [None] specifies that the Scheduler continues processing for further actions.
Please note
conditions:

the

following

Scheduler

operation

The Scheduler Desktop pauses during keystrokes, mouse clicks or movements, menu pull
down operations, and dialog displays, but resumes polling after an allotted time delay once
these actions end.
To operate the Scheduler with the [DateTime] option, select the [System Config] option in the System menu and set the system clock on
([Clock]:On) in the Desktop Configuration dialog
box that displays.
To reset the Scheduler functions to defaults, enter the following command at the DOS prompt:

DEL\ELIXIR\DESKTOP\SYSTEM\DISPATCH\*.SRV
<Enter>
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The Scheduler Desktop is single tasking and you
should operate it on a dedicated workstation. You
can accomplish Full Scheduler operations without
using network interrupts and you can perform this
from a DOS-based system.
The Scheduler Desktop is operational in nonnetwork environments, and can process files sent
over modems for printing to a remote printer.
Scheduler Desktop examples
This section describes examples of using the Scheduler Desktop.
Scheduler example 1
The following example describes setting up a Scheduler action to run a batch file at one minute past noon.
The example assumes that you set up the Scheduler
Desktop on a dedicated PC, attached it to a network,
and if applicable, defined the Network Scheduler directory to which files print to disk.
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1.

Select the [Scheduler Setup] option from the
Special menu and select the options you want
in the dialog box that displays (the options as
described earlier in this section).

2.

Select the [Scheduler Actions] option from the
Special menu and enter or select the following
to set up a Scheduler action based on a
DateTime test:
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[Task] 1
[Task test] On DateTime
[Filename(s)] *.SYS
[Date] 02 [Month] 12 [Year] 92
[Hour] 12 [Min] 1 [Sec] 0
[Action to take] BATchFile
[Name] JOBXXX
[After action] Task processing OFF

Figure 5-13. Testing for a passed
date/time example
This example sets up Scheduler action number 2 to
run the file JOBXXX on 12/02/92 at 12:01 PM.
If [Any] is selected for the Date, the Scheduler action
would occur every day at 12:01 PM.
Scheduler example 2
The following example describes setting up a Scheduler action that continuously runs a utility at specified
time intervals.
1.

Select the [Scheduler Setup] option from the
Special menu and select the options you want
in the dialog box that displays (the options as
described earlier in this section).

2.

Select the [Scheduler Actions] option from the
Special menu and enter or select the following
to set up a Scheduler action based on a Test
TRUE test:
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Task] 2
[Task test]Test TRUE
[Action to take] Usertool
[Name] NETCOMX
[After action] None

Figure 5-14. Testing for a TRUE
condition example
This example sets up Scheduler task number 2 to run
the usertool NETCOMX continuously at intervals
specified in step 5 in the Scheduler setup section.
You can use this Scheduler action to periodically send
messages over the network to inform nodes that the
Scheduler is active and waiting.

Viewing files
The Viewer icon allows you to link applications to file
extensions so that copying a file with a certain extension to the icon starts the application and loads the
file.
For example, you can link all .PCX file to the Windows
PaintBrush program so that copying a .PCX file to the
Viewer icon starts PaintBrush and displays the .PCX
file.
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To link applications to file extensions, use any ASCII
editor to edit the ELX.INI file in the drive:\WINDOWS
directory.
You can also click the right mouse button on the
Viewer icon to start Windows Notepad with ELX.INI
loaded.
In the file, under the [Viewer_Filemap] section add
lines in the following format:
extension=application
extension
is the file extension
application
is the executable linked to extension.
For example:
PCX=PBRUSH.EXE
This line links .PCX files to the PaintBrush application.
Viewing Elixir graphics files
The Viewer icon also allows you to display Elixir format graphics (.LP3) and screen graphics (.LW8) by
copying the files to the icon. You can copy the above
files from any folder to the Viewer icon.
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Figure 5-15. Elixir graphics (.LP3) display example
The Elixir Image Viewer application displays Elixir
graphics or the screen versions of Elixir graphics in an
image window, as shown in the above example.
From the File menu select [Attributes] to display information about the graphics, [Print] to print the graphics,
and [Exit] to exit the Viewer.
Clicking on the arrows in the image window header allows you to zoom in to 2X, 4X, 8X, 16X, and 32X
magnifications and to zoom out to -2X, -4X, and -8X
magnifications. The printed image size also displays
(PRN displays in the window header).
When displaying magnifications greater than 1X, the
left of the window displays the magnified view and the
right of the window shown a portion of the image at 1X
magnification.
Clicking on the button to the right of the arrow toggles
a grid at magnifications of 8X or greater.
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Moving the screen pointer in the window displays the
coordinates of the pointer in dots with respect to the
top left corner of the graphics.
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Peripheral devices

This chapter describes how to access and use peripheral devices connected to your PC. Devices covered
in this chapter include the diskette drives (internal or
external) and scanners.
The "Local printers" appendix describes use of a supported local printer.
See the Elixir ElixirScan User Guide for detailed information if you plan to use the ElixirScan application
with your scanner.

Diskette drive
You access diskette drives through the Desktop Diskette icon.
The Diskette icon allows you to:
specify the drive letter of the diskette drive you
want to access
copy files from the hard disk to a diskette
copy files from a diskette to the hard disk
format a high or low density diskette in DOS or
DOS-Elixir formats (DOS format with the standard
Elixir directory structure on the diskette).
The “Additional Desktop features” chapter describes
procedures for copying DOS files to and from diskettes.
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To assign a drive letter or to format diskettes, open
the Diskette icon to display the System Diskette dialog
box shown in the following figure. This dialog box also
displays when you copy one or more files to a diskette
(by copying file icons to the Diskette icon).

Figure 6-1. System Diskette dialog box
To specify a drive letter, enter the letter for the Diskette Drive option. Any actions you subsequently perform using the Diskette icon apply to the diskette drive
you specify.
To format a diskette, select [Perform FORMAT] for
the [Diskette Access] option, then select the format
type for the [Diskette Type] option.
When you format a diskette the following options
apply:
DOS User-Defined
Formats the diskette using the DOS FORMAT
command.
DOS Elixir
Formats the diskette using the DOS FORMAT command and creates an \ELIXIR subdirectory on the
diskette.
When you copy files to and from a diskette, the following options also apply:
Directory on Diskette to open
The diskette directory you want to access. The default is A:\*.*
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Diskette Access
[Perform FORMAT] - formats a diskette (see above);
[For READing] - displays a window showing a list of
files and directories on the diskette. [For WRITing] applicable only when you copy files from the hard
disk; copies the hard disk files to the diskette.

Scanner device
You can access any scanning device connected to
your PC through the Desktop Scanners icon when you
have the appropriate scanner software installed that
can create 300 dpi .TIF or .PCX files.
Before using your scanner, configure the Desktop as
described in the following section.
You can run only one scanner from the Desktop.
Configuration
To use your scanner from the Desktop, first set the
scanner specifications as follows:
Select the Scanners icon and press <F2> or select
[Properties] from the File menu. The User Application
Setup dialog box shown in the following figure displays:
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Figure 6-2. User Application Setup dialog box
The User Application Setup dialog box contains the
following options:
Command to Execute
The command that executes the application you want
associated with the icon. For example, to create a
WordPerfect icon, you would specify WP.
If you want to link the application to files in the same
directory as the application (see the “Linking files to an
already-defined User Tool” section), you can also type
in the DOS command with an embedded %1 parameter. The embedded %1 parameter specifies the location in the command at which you want the file name
to appear. See also the [Prompt for parameters]
option.
'Nickname' for application
A nickname (up to 8 characters) for the application
you want to run. After creating an icon, the User
Tools window displays the icon with the nickname under it.
Optional Long Name
A descriptive name for the application (up to 29 characters). The long name is informational only; it identifies the application in the dialog box.
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Working Directory
The DOS path for the executable. Use this field if the
application you are running is not present in the
drive:\ELIXIR directory and if you have not specified a
DOS PATH= statement for the directory in which the
application executable resides.
Command Options
Select [DOS Application] if running a DOS application
(enables the [Command Attributes] options).
[Send Only Filename] uses only the stem name of the
file for command execution.
Select [Prompt for parameters] if you want the program to prompt you to enter an argument that appends to the command in [Command to execute].
This displays a dialog box allowing you to enter an argument when you run the application. Leave unselected (the default) to run the application without
prompting for an argument.
[Run Minimized] executes the command in a minimized window.
Command Attributes
Select [Command is .BAT file] if the command you
specify is a DOS batch file. This redisplays the Desktop when you exit the application. Leave unselected
to return you to the directory specified in the batch file.
If the application is a batch file that calls another batch
file, the Desktop does not redisplay when you exit the
application (see the “Starting batch files” section in
this chapter for more information).
Select [Pause after execution] to pause after exiting
the application and to request entering any key to continue before returning to the Desktop. Leave unselected to return to the Desktop after exiting the
application.
Display Options
[Window] displays command execution in a window.
[Full Screen] displays command execution in a full
screen environment.
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[Browse] button
Click on to display the contents of a DOS directory
(which you can change) from which you can select a
file.
Using scanners
To use your scanner, open the Scanners icon. After
confirming that the information in the User Application
Setup dialog box is correct, click on [OK] to start the
scanner application.
See your scanner user manual for information on configuring your system for your scanner..

Using the Elixir HP print driver
The Elixir HP print driver produces files that require
substantially less disk space and take less time to
print.
To use the Elixir HP print driver, follow these steps:
1.

Select and drag the files to the Printers icon.

2.

In the Print dialog box, select the [Elixir HP
Driver] and click on [Setup].

The Elixir HP Driver dialog box displays. Select from
the following options:
Printer
The type of HP LaserJet printer (II, III or 4).
Printer Port
As Appropriate, either [LPT1], [LPT2] or [LPT3].
Output Mode
Either [Use PCL commands] or [Use rasterization].
The [Use rasterization] option allows you to print objects such as circles and paths that HP PCL may otherwise ignore or print as other objects.
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Font Substitution Tables
Either [No] to use printer-resident fonts or [Selected]
to use fonts from the table you enter in the [Selected
Table] option. You can browse the font tables listed in
the Select Font Table dialog box by clicking on the
[Select Font Table] button.
Create As Macro
A number value in [Macro ID number] to store your
form on the printer for future use.
3.

After selecting your options, click on [OK].

4.

To print the file, click on [OK] in the Print
dialog box.
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File conversions

The main function of the Elixir Forms Editor Desktop
is to convert form, font, graphics, document and job
files to and from different formats.

General procedures
Before copying or converting a file, you may want to
first check the file's property specifications.
To display file properties:
1.

Select one or more files in any open window.

2.

Either press <F2> or select [Properties] from
the File menu.

Figure 7-1. File Object Properties dialog box
3.

The File Object Properties dialog box displays with the following options:
File name and extension
The name, including any extension, of the selected file. This is the only option you can
change. To rename the file, enter a new file name
and extension.
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File type
The type of file selected (for example, Elixir, HP
PCL or PostScript.
File size
The size of the selected file in bytes.
Date of last access
The date you created or last changed the file.
Time of last access
The time you last accessed the file.
Note that if you select more than one file, a dialog
box for each subsequent file displays when you
click on [OK] or [Cancel].
4.

After you select your options, click on [OK].

The easiest way to convert files is to use the Forms
Editor Desktop Converter icon. To convert files, simply
follow these steps:
1.

Select the file(s) you want to convert from the
appropriate Elixir or Input folder.

2.

Copy the file(s) to the Converter icon.

3.

In the dialog boxes that subsequently display, specify the output format(s) to which
you want the file(s) converted.
Based on the file type (as determined by file location and extension), the Converter generates one
or more output files with the correct file extensions, and writes them to the appropriate Output
folders.
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Elixir folders
This section explains how you convert files to different
formats. You may want to first review the “Elixir folders” chapter before proceeding with this section.
The Forms, Fonts, Graphics, Documents and Jobs
folders displayed on the Desktop each contain subordinate Input, Elixir and Output folders.

Figure 7-2. Subordinate folders example
Forms folder
The Input Forms folder comprises folders containing
non-Elixir, single-page form files that you can convert
to other formats. To convert a non-Elixir single-page
file to another format, you must first copy it to the appropriate folder in the Input Forms folder.
The Elixir Forms folder contains Elixir-format form
(.ELX) files and/or other subordinate folders containing Elixir forms. When you create Elixir forms or convert form files to Elixir-format, the files write to this
folder.
When you convert form files from the Input Forms
folder to any non-Elixir format, or when you convert
Elixir forms from the Elixir Forms folder, the resulting
output form files write to folders in the Output Forms
folder.
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Fonts folder
The Input Fonts folder comprises folders containing
non-Elixir font files that you can convert to other formats. To convert a non-Elixir font, you must first copy
it to the appropriate folder in the Input Fonts folder.
The Elixir Fonts folder contains Elixir-format font
(.HDR) files. When you create Elixir fonts, or convert
font files to Elixir format, the files write to this folder.
When you convert font files from the Input Fonts
folder to any non-Elixir format, or when you convert
Elixir fonts from the Elixir Fonts folder, the resulting
output font files write to folders in the Output Fonts
folder.
Graphics folder
The Input Graphics folder comprises folders containing non-Elixir graphics files that you can convert to
other formats. To convert a non-Elixir graphics file,
you must first copy it to the appropriate folder in the
Input Graphics folder.
The Elixir Graphics folder contains Elixir-format graphics (.LP3) files. When you create Elixir Graphics or
convert graphics files to Elixir-format, the files write to
this folder.
When you convert graphics files from the Input Graphics folder to any non-Elixir format, or when you convert
Elixir graphics from the Elixir Graphics folder, the resulting output files write to folders in the Output
Graphics folder.
Documents folder
The Input Documents folder comprises folders containing non-Elixir multi-page documents.
The Elixir Documents folder contains .DAT files, which
are ASCII files referencing the Elixir-format form
(.ELX) files comprising a multi-page document.
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The Elixir Forms folder contains the .ELX files that the
.DAT files reference. See the "Local printers" appendix for procedures on how to create a .DAT file using
.ELX files.
Jobs Folder
Together with the Elixir AppBuilder, the Jobs Folder
supports creation of multiple Elixir form print files
(jobs). A job comprises form files and a print ticket,
and includes formatting information for individual
pages and the print run. If installed, the Elixir
AppBuilder starts when you open an associated file in
the Jobs folder.

Initial converter setup
Before beginning file conversions, you may find it
helpful to set up several parameters that are common
to most conversions for display in dialog boxes when
you convert files. You specify these options in the
Converter Properties dialog box.
To display the Converter Properties dialog box, perform one of the following:
Select the Converter icon, then select [Properties]
from the File menu.
Select the Converter icon and press <F2>.
Select the Converter icon, then right-click on the
icon.
Select [Converter Props] from the System menu.
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Figure 7-3. Converter Properties dialog box
The Converter Properties dialog box contains the
Form and Font converter options described in the
"Converting forms" and "Converting fonts" sections of
this chapter.
After changing information in the above dialog boxes,
click on [OK] to save your changes and return to the
Converter Properties dialog box. Note that the
changes you make in the Form and Font Converters
dialog boxes save even if you click on [Cancel] in the
Converter Properties dialog box.
Clicking on the [Converter Properties] button displays
the Converter Properties Dialog dialog box.

Figure 7-4. Converter Properties Dialog
dialog box
Working Directory
Specifies the directory in which temporary reads and
writes take place during file conversion. The default is
the root (\) directory. Specifying a RAM disk for faster
conversions is recommended.
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Confirm file overwrites during conversion
Displays a dialog box requesting confirmation before
overwriting an existing file. Not selecting this option
automatically overwrites existing files.
Show properties before conversions
Displays the appropriate dialog box prior to file conversion. If not selected, the dialog box does not display and the conversion uses previously selected defaults.
Pause after conversions
Specifies a pause after each conversion.
Use Elixir HP PCL and PostScript converters
Specifies use of Elixir printer drivers when converting
Elixir forms to HP PCL 4 and PostScript formats.
Leave unselected to use Windows printer drivers.
Note that Elixir printer drivers produce optimized files
that require substantially less disk space, while creating printer output identical to Windows printer drivers.
Stop process after: Error/All files processed.
Specifies whether you want conversion to stop either
after an error or after file processing.
Clicking on the [Message Reporting] button displays
the Message Options Dialog dialog box.

Figure 7-5. Message Options Dialog dialog box
Select options to either show messages after processing or write messages to a .LOG file with the specified
stem name.
You can also select to append new messages to an
existing .LOG file or overwrite an existing .LOG file.
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File conversion procedures
This section briefly describes file conversion steps.
Following sections provide more detailed descriptions.
To convert a form, font, graphics, document or job file
to a different format, follow these steps:
1.

To convert a non-Elixir file, copy the file to the
appropriate Input folder.
(If you want to convert an Elixir-format file, the
file may already reside in an Elixir folder.)

2.

Open the appropriate Input or Elixir folder and
select the file(s) you want to convert.

3.

Copy the selected file(s) to the Converter icon
using standard copy procedures.

4.

In the dialog box that displays, select the file
format(s) to which you want to convert the
selected file(s). You may be able to specify
more than one output format. Formats to
which you cannot convert display in gray.

5.

Press <Enter> or click on [OK] in the dialog
box. A second dialog box may display,
requesting more information. Press <Enter>
or click on [OK] to start the conversion
process.

The selected file(s) convert and the generated output
writes to the appropriate Output folder. If you specified
more than one output format in step 4, each input file
converts to the formats you selected and writes to the
appropriate Output folders.
Specifying options in the dialog boxes assigns parameters to Elixir file conversion utilities, as described
in the "Stand-alone utilities" chapter. Note that some
dialog boxes may not include all available options.
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A dialog box displays showing actual completion percentage (status) of the conversion. Following conversion, click on [OK] in the dialog box.
A message dialog box displays showing final disposition of the conversion, including any errors that may
have occurred.

Converting forms
This section describes how to convert a single-page
form.
The Elixir Forms Editor Desktop allows you to convert
Elixir forms (.ELX files) to HP PCL, PostScript, PDF,
XGF and XSOP formats. You can also rasterize and
convert a form to an Eixir-format image (.LP3) file.
To convert one or more forms from the Elixir Forms
folder (drive:\ELIXIR\FORMS\ELIXIR or a subordinate
directory), select and copy the files to the Converter
icon.

Figure 7-6. Form Converter Options dialog box
The Form Converter Options dialog box displays with
the following options:
Input Format
The format of the form selected for conversion.
Output
The formats to which you can convert a form. Unavailable formats are grayed.
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Converting Elixir forms to HP PCL format
You can convert forms to HP PCL using Windows
printer drivers (supplied with Windows) or by using the
Elixir HP PCL driver.
Using the Elixir HP PCL driver produces optimized
output files that are identical to, but significantly
smaller than, those produced by Windows drivers.
See the "Initial converter setup" section in this chapter
for more information on Elixir drivers.
To convert Elixir form files to HP PCL format:
1.

Copy the Elixir form(s) to the Converter icon.
The Form Converter Options dialog box displays.

2.

Select [HP PCL] and click on [OK].

Figure 7-7. FORMPRN Properties dialog box
3.

The FORMPRN Properties dialog box displays with the following options:

File Name
The name of the selected file.
Output
Select either [Printer] or [Disk].
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Printer Port
Select either [LPT1], [LPT2] or [LPT3].
Printer
Select either [2700], [4045], [4235], [4700] or [HP] (unavailable options are grayed).
Tray Number
Enter the desired printer paper tray number.
Copies
Enter the number of copies desired.
Spacing
[InterWord] justifies text by adding or deleting spaces
between words. [InterChar] justifies text by adding or
deleting spaces between characters. Selecting [InterWord] reduces complexity so that forms print faster,
while selecting [InterChar] may make the form more
readable, but print slower.
Printer Options
Select one of the following (unavailable options are
grayed):
[Print] to send your form to the printer
[Store] to store your form on the printer hard disk
[StorePrint] to both print your form and store it on the
printer
[Constant] to store your form (one page only) in the
printer's memory until the printer is either reset or
turned off.
Macro Number
Enter the macro number assigned to your form. This
stores your form in the printer's memory until the
printer is either reset or turned off.
Format
Select one of the following (unavailable options are
grayed):
[ASCII] to produce ASCII output for writing to a disk
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[EBCDIC] to produce EBCDIC output for Xerox printers connected to your PC via coaxial cable and a protocol server
[SmartBox] if your PC is connected to the printer
through a SmartBox or Agile protocol converter.
Printer Font Loading
Select one of the following (unavailable options are
grayed):
[Always] to download fonts each time you print.
[Once] to download fonts to the printer only once, as
they are encountered (fonts stay resident until the
printer is reset).
[Never] to not download fonts to the printer (use only
fonts that are resident).
Page Shift
Enter the number of dots you want the printed page
shifted either right ([Xshift]) or down ([Yshift]). Negative values are permissible.
4.

After you select your options, click on [OK].

Converting Elixir forms to PostScript
You can convert Elixir forms to PostScript using Windows printer drivers (supplied with Windows) or by using the Elixir PostScript driver.
Using the Elixir PostScript driver produces optimized
output files that are identical to, but significantly
smaller than, those produced by Windows drivers.
See the "Initial converter setup" section in this chapter
for more information on Elixir drivers.
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To convert Elixir form files to PostScript format:
1.

Copy the Elixir form(s) to the Converter icon.
The Form Converter Options dialog box displays.

2.

Select [PostScript] and click on [OK].

Figure 7-8. ElixiScript Converter Properties
dialog box
3.

The ElixiScript Converter Properties dialog
box displays with the following options:

PostScript Font Mapping Table
Displays the full DOS path name of the font mapping
table (PSFONT.MAP). This table corresponds PostScript fonts to DOS file names, required because
DOS limits file names to 8 characters and PostScript
font names can contain more. Note that you cannot
change the full path name of the font mapping table
(\ELIXIR\PSSTASH\PSFONT.MAP).
Line Thickness
The default values shown are fractional point sizes for
standard PostScript thin, medium and thick lines. Select [Thin], [Medium] or [Thick] to change respective
point size default values.
Shading Levels
The default values shown are standard "set gray" values for PostScript light, medium and dark shading.
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Select [Light], [Medium] or [Dark] to change respective
shade level default values.
Source Directories
The directory containing sample PostScript-compatible screen fonts (drive:\ELIXIR\FONTS\SCREEN\
DEMO). For correct printing, the dimensions of the
screen fonts used for a form must match the built-in
fonts in your PostScript printer. You can generate
PostScript screen fonts using the Efont Factory (see
the "Converting fonts" section in this chapter).
Place Each Character
Select if the fonts in the form you are converting did
not convert from standard Adobe Type 1 fonts. Selecting this option approximates correct font positioning in the PostScript file.
If you selected the Windows printer driver, the Print
Driver Dialog dialog box displays, with the following
options.

Figure 7-9. Print Driver Dialog dialog box
Orientation
Specify printed page orientation (either [Landscape] or
[Portrait]).
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Page Shift
Specify the number of dots you want the printed page
shifted right (X-shift) or down (Y-shift). Negative values are permissible.
Copies
Specify the number of copies desired.
Load Fonts
[Always] includes (in the output data stream) every
font used on every form you convert. [Once] includes
every font the first time that the Desktop session encounters it. [Never] does not include fonts in the output data stream (this option assumes that all required
PostScript fonts reside on the printer).
Setup
Specify Windows setup parameters for your printer.
You must use the Efont Factory to generate the
screen fonts for the forms you want to convert. See
the “Generating fonts from outlines” section in this
chapter for more details.
After conversion, one-page PostScript-format files
write to the Output PostScript Forms folder
(drive:\ELIXIR\FORMS\PSOUT). Converted PostScript files have .PS extensions.
For information about printing PostScript files, see the
"Local printers" appendix.
4.

After you select your options, press [OK].

Converting forms to Elixir graphics files
To convert or rasterize a form to an Elixir graphic
(.LP3 file in drive:\ELIXIR\PICS\PRINTER):
1.

Copy the Elixir form(s) to the Converter icon.
The Form Converter Options dialog box displays.

2.

Select [Images] and click on [OK].
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Figure 7-10. Image Converter Options dialog box
3.

The Image Converter dialog box displays with
the following options:

Image Resolution
Specify image resolution as either [240] or [300] dpi
(the default).
Text Justification
[InterWord] justifies text by adding or deleting spaces
between words while [InterChar] justifies text by adding or deleting spaces between characters. Selecting
[InterWord] reduces complexity so that forms print
faster, while selecting [InterChar] may make the form
more readable but print slower.
Note that Elixir versions of all fonts in the form must
exist.
4.

After you select your options, press [OK].

Converting Elixir forms to PDF format
The Elixir Forms Editor Desktop allows you to convert
a single-page Elixir form to Adobe's Portable Document Format (PDF) without first installing the Elixir extended PDF converter; however, converting
multi-ple-page form and document files does require
installation of the extended PDF converter.
To convert Elixir forms to PDF format:
1.
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2.

Select [PDF] and click on [OK].

Figure 7-11. PDF Settings dialog box
3.

The PDF Settings dialog box displays with the
following options for creating .PDF out- put
using Adobe Acrobat products:

Input ELX File
The name of the input file (form) to be converted.
Output PDF Directory
The output directory for the .PDF file. The default is
drive:\ELIXIR\DOCS\PDFOUT.
DIR
Press this button to browse and select files residing
on the Output PDF Directory.
Output File
The name of the output file. If you are processing multiple files, leave this option blank.
Substitute All Fonts (MM fonts)
Creates Multiple Master versions of all fonts in your
job. This option requires that Elixir versions of the
fonts are in drive:\ELIXIR\FONTS\ELIXIR.
Use this option when your document text consists
mostly of alphanumeric information with common
typefaces.
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The Converter scans each Elixir font used in the form
and embeds hints for generating Adobe Multiple Master instances into the .PDF file. As these are vector
fonts, .PDF file size is minimized.
To view the file you must have Adobe Type Manager
3.0 or newer installed. Note that custom characters
(such as logos, special symbols fonts or symbol fonts)
display as regular alphanumeric characters. For documents containing fonts of this type, see the [Rasterize
All Fonts] or [Use Font Mapping] options described
below.
Rasterize All Fonts (Type 3 fonts)
Embeds all form fonts into the .PDF file as Adobe
Type 3 raster fonts. This option requires that Elixir versions of the fonts are in drive:\ELIXIR\FONTS\
ELIXIR.
Select this option when most fonts used in your form
comprise special characters or images (such as a
logo). This ensures that the special characters are
viewable when the file is distributed. Because the actual raster graphics of the characters are embedded in
the file, .PDF files are fairly large.
Use Font Mapping
Uses a mapping table to control, on a font-by-font basis, the .PDF file's font format. Allows the Converter to
use a combination of Multiple Master, Adobe Type 3
raster fonts and Adobe Type 1 (PostScript) name
mappings for the fonts. The name entry box allows
you to specify the mapping file. The default file is
drive:\ELIXIR\PSSTASH\PSFONTS.MAP.
Use this option when form character mappings do not
match standard Windows character mappings.
When you select this option, the Converter scans the
specified file and compares the Elixir font names used
in the form with those names found in the file (see example below). If a match for a font is not found, a Multiple Master instance is generated. If a match is found,
the Converter looks at the right half of the entry to determine whether to rasterize as a Type 3 font or call
the font out by a Type 1 name.
The mapping file is an editable text file with a simple
equivalence table. The syntax for entries is:
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font name= [RASTERIZE] [TYPE1fontname-weight
point-size]
For Example:
TR11NP=Times-Roman 11
TR12NP=Times-Roman 12
HE07BP=Helvetica-Bold 7
CH14SP=ZapfChancery-MediumItalic 14
SIGFNT=RASTERIZE
If you specify a Type 1 font, you must enter it exactly
as it appears in the Adobe Type Manager "Installed
ATM Fonts" window. If you want to view the resulting
.PDF file on another PC, the chosen font must also be
available through ATM on the target machine.
MAP
Press this button to browse and select other files residing on the Font Mapping Table.
KMP MAP TABLE
Uses a customized mapping table to control translation of .PDF file keystrokes. The name entry box displays the specific mapping file to be used for the
conversion. The default file is drive:\ELIXIR\FONTS\
MAPS\X1000437.KMP (U.S.) See the ElixirForm User
for AFP Guide and ElixirFont for AFP User Guide for
more information.
KMP
Press this button to browse and select other files residing on the Keyboard Country Mapping Table. See
the ElixirForm User for AFP Guide and ElixirFont for
AFP User Guide for more information.
4.

After you select your options, press [OK].

ELIXIR FORMS EDITOR DESKTOP USER GUIDE

7-19

FILE CONVERSIONS

Converting Elixir forms to XGF format
The Elixir Forms Editor Desktop allows you to convert
a single-page Elixir form to Xerox Generic Format
(XGF) without first installing the Elixir extended
XGFconverter; however, converting multiple-page
form and document files does require installation of
the extended XGF converter.
To convert Elixir forms to XGF format:
1.

Copy the Elixir form(s) to the Converter icon.
The Form Converter Options dialog box displays.

2.

Select [XGF] and click on [OK].

Figure 7-12. XGF Settings dialog box
3.

The XGF Settings dialog box displays with the
following options for creating .XGF output:

Output Directory
The output directory for the .XGF file. The default is
drive:\ELIXIR\DOCS\XGFOUT.
Output File
The name of the output file. If you are processing multiple files, leave this option blank.
Rasterize All Fonts (Type 3 fonts)
Embeds all form fonts into the .XGF file as Adobe
Type 3 raster fonts. This option requires that Elixir versions of the fonts are in drive:\ELIXIR\FONTS\
ELIXIR.
7-20
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Select this option when most fonts used in your form
comprise special characters or images (such as a
logo). This ensures that the special characters are
viewable when the file is distributed. Because the actual raster graphics of the characters are embedded in
the file, the XGF files are fairly large.
Use Font Mapping
sis, the .XGF file's font format. Allows the Converter to
use a combination ofmAdobe Type 3 raster fonts and
Adobe Type 1 (PostScript) name mappings for the
fonts. The name entry box below this option allows
you to specify the mapping file. The default file is
drive:\ELIXIR\PSSTASH\PSFONTS.MAP.
Use this option when form character mappings do not
match standard Windows character mappings.
When you select this option, the Converter scans the
specified file and compares the Elixir font names used
in the form with those names found in the file (see example below). If a match for a font is not found, the
following warning message is displayed:
"Font <fontname> maps to NO PostScript equivalent"
If a match is found, the converter looks at the right
half of the entry to determine whether to rasterize as a
Type 3 font or call the font out by a Type 1 name.
The mapping file is an editable text file with a simple
equivalence table. The syntax for entries is:
font name= [RASTERIZE] [TYPE1fontname-weight
point-size]
For Example:
TR11NP=Times-Roman 11
TR12NP=Times-Roman 12
HE07BP=Helvetica-Bold 7
CH14SP=ZapfChancery-MediumItalic 14
SIGFNT=RASTERIZE
ELIXIR FORMS EDITOR DESKTOP USER GUIDE
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If you specify a Type 1 font, you must enter it exactly
as it appears in the Adobe Type Manager "Installed
ATM Fonts" window. If you want to view the resulting
.XGF file on another PC, the chosen font must also be
available through ATM on the target machine.
4.

After you select your options, click on [OK].

Converting Elixir forms to XSOP format
The Elixir Forms Editor Desktop allows you to convert
single-page Elixir forms to Xerox Services for Open
VMS Printing (XSOP) format, in support of Xerox midrange printers running off a DEC host computer. For
XSOP conversions, choose only TrueType, ATM or
Elixir Efont Factory fonts.
To convert Elixir form files to XSOP format:
1.

Copy the Elixir forms to the Converter icon
The Form Converter Options dialog box displays.

2.

Select [XSOP] and click on [OK].

Figure 7-13. XSOP Converter Properties dialog box
3.

The XSOP Converter Properties dialog box
displays with the following options for
creating XSOP output:

PostScript Font Mapping Table
Displays the full DOS path name of the font mapping
table (PSFONT.MAP). This table corresponds PostScript fonts to DOS file names, required because
DOS limits file names to 8 characters and PostScriptfont names can contain more.
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Note that you cannot change the full path name of the
font
mapping
table
(\ELIXIR\PSSTASH\PSFONT.MAP).
Output Device
Select either [Disk] or the desired printer port ([LPT1],
[LPT2], [LPT3]).
Note that if you select DISK as the output option, the
file writes to drive:\ELIXIR\FORMS\PSOUT.
Number of Copies
Specify the number of copies desired.
Place each character
Select if the fonts in the form you are converting did
not convert from standard Adobe Type 1 fonts. Selecting this option approximates correct font positioning in the PostScript file.
4.

After you select your options, click on [OK].

Converting fonts
This section describes font conversion and generation
procedures.
The Elixir Forms Editor Desktop allows you to perform
the following font operations:
convert Elixir fonts to HP PCL, Windows and
Screen formats
convert contour (outline) fonts to Elixir, HP PCL,
Windows and Screen formats
convert ATM and TrueType fonts to Elixir, HP
PCL and Screen formats
generate Elixir, non-Elixir and Screen fonts
To convert fonts, select and copy either .HDR font
components from the Elixir Fonts folder or fonts from
the Input Fonts folder to the Converter icon. The Font
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Converter Options dialog box displays.

Figure 7-14. Font Converter Options
dialog box
The Font Converter Options dialog box contains the
following options:
Input Format
The format of the font selected for conversion.
Output
The formats to which you can convert the font. Unavailable formats are grayed.
Converting fonts to HP PCL format
To convert fonts to HP PCL format:
1.

Copy the font file(s) to the Converter icon.
The Font Converter Options dialog box displays.

2.

Select [HP PCL] and click on [OK].

Figure 7-15. HP Font Converter
Options dialog box
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3.

The HP Font Converter Options dialog box
displays with the following options:

Create All 4 Rotations
Select to create font versions rotated in all four (0o,
90o, 180o and 270o) inline print directions.
Create Rotated Version
Select to create rotated font version for proof printing
a form containing rotated fonts.
4.

After you select your options, click on [OK].

Generating fonts from outlines
The Desktop includes the Elixir Font Factory (Efont
Factory), a utility that uses contour fonts compatible
with Bitstream Facelift to generate Elixir-format and
printer-format fonts. The Efont Factory cannot generate fonts from Bitstream Fontware and Fontwarecompatible fonts.
The Desktop installation procedure installs 35 contour
fonts compatible with Bitstream Facelift in drive:\
ELIXIR\FONTS\CONTOURS (Input Contour Fonts
folder).
If not already installed, you can install Bitstream Facelift fonts on your PC as follows:
Select [Install Fonts] from the Special menu. The
program prompts you to insert the first Bitstream
Facelift diskette into your diskette drive and follow the
instructions displayed on your screen.
The Efont Factory allows you to:
generate up to six point sizes of a font in each
conversion
generate whole or partial character sets
generate different font resolutions
automatically generate font names
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perform additional transformations such as font
orientation and darkening.
You can display the Contours fonts window by either
opening the Outline Fonts icon, selecting [Efont Factory] from the Special menu or typing <Alt> + <E>.
The following figure shows the Input Contours folder
window.

Figure 7-16. Input Contours folder window
To generate Elixir fonts from a contour font:
1.

Copy one or more contour fonts from the
Input Contours folder to the Converter icon.
The Font Converter Options dialog box displays.

2.

Select an output format and click on [OK].

Figure 7-17. Outline-to-raster font generator dialog box
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3.

The Outline-to-raster font generator dialog
box displays with the following options:

Font Name
The name of the converted raster font(s). If converting to more than one point size (see the description
for the next option), enter a file name stem ending
with 01. Names for converted files increment by 1 for
each point size selected, in order of ascending point
size. If you convert more than one contour font file to
multiple point sizes, the converted files are similarly
named. The maximum number of files you can create
is 99.
Autoname
Names font files as described in the “Font naming
conventions” section that follows. Using [Autoname]
rather than [FontName] for naming fonts is recommended. To identify newly created fonts using this
option, view the fonts using the [By Date] option in the
Elixir Fonts folder View menu.
Point Size(s)
The point size(s) for the converted font file(s). Enter
any size from 2 to 99. See the [Font Name] option description for information about converting to more than
one point size.
Res(olution)
The resolution (in dots per inch, dpi) of the target
printer. The default is 300 dpi.
Char(acter) set map
The character set of the raster font being generated:
[US], [ISO-XB] (international ISO), [Custom] (creates
full character sets), [0-Z] (upper case and numerals
only), [a-z] (lowercase only). Each corresponds to a
font generation mapping table. A mapping table is a
.GMP ASCII file in drive:\ELIXIR\FONTS\MAPS. Each
line in a .GMP file is of the form mm=nn, where mm is
the hex position number of a character in the input
font and nn is the hex position number of the corresponding character in the output font.
Range
The number for the first and last characters you want
to convert, in [DEC] (decimal), [HEX] (hexadecimal) or
[ASC] (ASCII) representation. The default range is
0-255 (decimal).
ELIXIR FORMS EDITOR DESKTOP USER GUIDE
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Prepare for PostScript use
Select this option when printing on a PostScript printer
to place the screen font reference in the fonts mapping table, PSFONT.MAP, a file containing a mapping
between the PostScript name and DOS file name for
each font. When you do not select this option, the
fonts mapping table does not include the PostScript
font name.
Keep Left Kern
Keeps left kerning information for left-kerned characters. When you do not select this option, you delete
drive:\ELIXIR\FONTS\TABLES directory containing
width, height, offset, left, and right kerning, and ASCII
index values for each font character. The width table
has the same name as the font file and has a .TFB file
extension. Information in .TFB files allows you to build
a left kerning table for using the font in non-Elixir
environments.
Check for size limit
Ensures that the generated font size is within your
printer's size limit. [64k] and [128k] truncate the font
at the specified limit and issue an error message.
[None] generates the font regardless of size.
Creating a screen font larger than 128 KB may result
in errors. See your printer manual for printer font size
limits.
Darken characters
Due to the limitation of some printers, small fonts may
print lightly. To compensate for the problem, use
[Darken RT] to darken horizontally when printing in
portrait orientation and [Darken DN] to darken vertically when printing in landscape orientation. The default is [None].
Font Orientation
Specifies [Portrait], [Landscape], [Inverse Portrait] or
[Inverse Landscape] orientation for output fonts (see
the glossary for explanation of these terms).
Place Screen Fonts in
The directory where screen fonts write to (creates a
new directory if one does not exist).
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4.

After you select your options, click on [OK].

Font naming conventions
When you select [Autoname] in the Outline-to-raster
font generator dialog box, Efont Factory generates
raster fonts and names them using the following
conventions:
A six-character stem name generates.
The first two characters of the generated font
name describe the font family from the following
table:
Font Family

First two file characters

Courier

CO ( Courier)

Dutch

TR (Times Roman)

Swiss

HE (Helvetica)

ITC-Avant-Garde

AG (Avant Garde)

ITC-Bookman

BM (Bookman)

Swiss Narrow

HN (Helvetica Narrow)

Symbol-Set

SY (Symbol)

Century-Schoolbook

CS (Century Schoolbook)

ITC-Zapf-Chancery

CH (Chancery)

ITC-Zapf-Dingbats

DB (Dingbats)

Zapf-Calligraphic

PA (Palatino)

If you add a new font family without a descriptor
to the Input Contour Fonts folder, the Efont Factory assigns XX as the first two characters.
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The third and fourth characters of the generated
font name describe the point size you enter in the
Outline-to-raster font generator dialog box.
The fifth character of the generated font file name
describes the type style from the following table:
Type style

Character used

Normal

N

Demi

D

Bold

B

Italic

I

Oblique

O

Light Italic

Q

Demi Italic

R

Medium Italic

S

Bold Italic

T

Demi Oblique

U

Bold Oblique

V

The sixth character of the generated font name
describes the orientation from the following table:
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Orientation

Character

Portrait

P

Landscape

L

Inverse portrait

I

Inverse landscape

J

For example, a converted ITC-Zapf-Chancery, 12
point, bold, portrait font has a name of CH12BP.
You can assign two-character descriptors for additional fonts not included in the above tables as follows:
Use the DOS TYPE command to display the contents
of the .TDF file for the font (the Input Contour Fonts
folder contains .TDF font files). To determine the
.TDF file name, select a font and drag it within the
folder. The cursor changes and identifies the font
name. Press <Esc> to return to a standard cursor.
The .TDF file displays the HP code, a two-character
font family identifier.
Using an ASCII editor, edit BTFONT.NAM in
drive:\ELIXIR\FONTS\MAPS to add a line at the end
of the file that includes the full DOS name of the .TDF
file, a space, the two-character designator, a space,
and the typestyle.
Generating Elixir fonts
When using Efont Factory to create fonts for use in
Elixir Forms Editor, select the [Keep Left Kern] option
in the Outline-to-raster font generator dialog box.
Elixir Forms Editor supports left kerning, and selecting
this option spaces and kerns all form characters correctly on both the screen and the printer output.
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Generating non-Elixir fonts
If you want to use the Efont Factory to create fonts for
non-Elixir applications, do not select the [Keep Left
Kern] option. See the description for the [Keep Left
Kern] option in the “Generating fonts from outlines”
section in this chapter for more information.
Regenerating screen fonts
Screen version fonts differ for different monitors and
resolutions, and therefore require regenerating each
time you:
copy Elixir fonts from a PC on which Elixir for another monitor or resolution is installed
reinstall Elixir on your PC and specify a different
monitor or resolution.
Elixir Forms Editor requires screen fonts when you
create or edit forms. When creating screen versions
of forms you can preview Elixir fonts in the Elixir Fonts
folder.
Adding HP PCL fonts to Windows applications
The following procedure describes the steps necessary to add HP PCL fonts to your Windows application
fonts list.
1.

Open the Windows Control Panel and select
the Printers icon.
The Printers dialog box displays.
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2.

Select the desired printer in the Installed
Printers box and click on [Setup].

3.

Click on [Fonts], then in the Font Installer
dialog box, click on [Add Fonts].

4.

In the Add Fonts dialog box, set the directory
path to drive:\ELIXIR\FONTS\PRINTER and
click on [OK].
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The installer reads all soft font files in the directory and builds a list that displays a default font
name and point size.
Note that you can simplify this process by converting one font at a time.
5.

Select the desired font from the right list box.
The actual file name displays at the bottom of the
dialog box. Check the file name to ensure you selected the correct file.

6.

Click on [Add].
Unless otherwise necessary, accept the default
directory (drive:\PCLFONTS) by clicking on [OK]
in the Add fonts dialog box.

7.

Select the font from the left list box and click
on [Edit].
The Edit dialog box displays.

8.

Modify the name to match the font file name
and click on [OK].

9.

Exit to the Program Manager.

The HP PCL fonts are now available in the fonts list of

Converting graphics
This section describes graphics file conversion
procedures.
The Elixir Forms Editor Desktop allows you to convert
Elixir, .LP3, .BMP, .PCX, and .TIF file formats to
Elixir, .PCX, .BMP, screen and .TIF file formats. You
can also convert Elixir graphics files to tiles in an
Elixir-format font.
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To convert one or more graphics files from the Elixir
Graphics folder or sub-folder:
1.

Select and copy the files to the Converter
icon.

Figure 7-18. Image Converter Options
dialog box
2.

The Image Converter Options dialog box
displays with the following options:

Input Format
The format of the graphic selected for conversion.
Output
The formats to which you can convert the graphic. Unavailable formats are grayed.
3.

After you select your options, click on [OK].

Converting Elixir graphics to Tiles in a Font format
This option places a grid on an image and converts
each cell of the grid to a character in an Elixir font.
See the ElixirImage User Guide for more information.
To convert Elixir graphics to tiles in a font:
1.
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Copy the Elixir graphic(s) to the Converter
Icon.
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The Image Converter Options dialog box displays.
2.

Select [Tiles in a Font] and click on [OK].

Figure 7-19. Extra Converter Options dialog box
3.

The Extra Converter Options dialog box
displays with the following options:
Retile
Retiles the .TXT file associated with the Elixirformat (.LP3) file.
Orientation
Select [Port] for portrait, [Land] for landscape,
[InvPort] for inverse portrait or [InvLand] for inverse landscape format fonts.

4.

After you select your options, click on [OK].

Converting Elixir graphics to PCX and TIFF formats
To convert Elixir graphics to or from .PCX or .TIFF
formats:
1.

Copy the Elixir graphic(s) to the Converter
Icon.
The Graphic Converter Options dialog box displays with the following options:
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Figure 7-20. Graphic Converter Options
dialog box
The Graphic Converter Options dialog box contains
the following options:
Image Compression
For conversions to [Color IMG] format only. [None]
does not compress files. [Partial] compresses duplicate and blank (null) lines, and [Full] compresses duplicate and blank lines and optimizes for white space.
Output Destination
Select [Disk] or [Tape] as your output medium. If you
select [Tape] and your PC does not have an attached
tape unit, the converted file writes to a hard disk without issuing an error message.
Output Format
Select either [B&W], [Highlight Color] or [Full Color] for
image output format.
Highlight Color
(Applicable only when you select [Highlight Color] as
the [Output format] option). Select [Red], [Green] or
[Blue] for output highlight color.
Rotate Image
For conversions to IMG formats only. Selecting this
option rotates graphics by 90 degrees to allow correct
printing og a landscape graphic on a portrait form.
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Unavailable options are grayed..
Note that this version of the Elixir Forms Editor Desktop does not support color. To convert color forms,
you must switch to a Xerox Desktop and have the appropriate ElixiKey installed.
2.

After you select your options, click on [OK].

Restrictions and limitations
The program supports the following formats for converting .TIF files:
TIFF #

Import
support

Export
support

Comments

1

Yes

Yes

Uncompressed format. Also supports
256 level gray-scale graphics.

2

Yes

No

CCITT Group 3

4

Yes

Yes

CCITT Group 4 facsimile format. Best
compression for scanned and line art.

5

Yes

No

LZW (black-and-white) compression

32,771

Yes

No

Similar to TIFF #1. Can also support
256 level gray-scale.

32,773

Yes

No

Pack bits compression; used on Macintosh computers.

Converting Elixir graphics to BMP format
To convert Elixir graphics to .BMP format:
1.

Copy the Elixir graphic(s) to the Converter
Icon.
The Graphic Converter Options dialog box displays.

2.

Select [BMP] and click on [OK].
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Accessing DOS files
and applications

This chapter describes how Elixir Desktop allows access to DOS files and applications.

Desktop tools
The Elixir Desktop includes a number of tools that enable you to access DOS files and applications as
follows:
User Tools icon
The User Tools icon allows you to establish an icon
for any DOS application or batch file, so that doubleclicking on the icon executes (or starts) the application.
User Files icon
The User Files icon allows you to access all DOS files
and directories as icons.
The User Files icon also includes a Tool Link utility
that allows you to link a file with an application. Once
linked, double-clicking on the file starts the application
and loads the file.
Dispatcher icon
The Dispatcher icon allows you to store up to 12 DOS
commands with optional replaceable parameters.
When you copy a file to the Dispatcher icon and select
a command, the name of the file substitutes for the replaceable parameter.
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Creating an application icon
The User Tools icon allows you create icons for applications and batch files on your PC.
During software installation, the ELXWDATA User
Tools install.
The ELXWDATA User Tool starts a batch file that
generates a text file called ELXWDATA.TXT on the A:
drive diskette. The file contains the contents of your
AUTOEXEC.BAT, CONFIG.SYS and INSTALL.LOG
files and other information such as existing .APP and
.EXE files and system memory.
Creating an icon
To create an application icon, open the User Tools
icon to display the User Tools window.
The User Tools window is similar to other Elixir windows and includes an additional Tools menu title in
the window header.
From the Tools menu, select the [New Tool] option to
display the User Application Setup dialog box shown
in the following figure.

Figure 8-1. User Application Setup dialog box
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The User Application Setup dialog box displays the
following options:
Command to Execute
The command that executes the application you want
associated with the icon. For example, to create a
WordPerfect icon, you would specify WP.
If you want to link the application to files in the same
directory as the application (see the “Linking files to an
already-defined User Tool” section), you can also type
in the DOS command with an embedded %1 parameter. The embedded %1 parameter specifies the location in the command at which you want the file name
to appear. See also the [Prompt for parameters]
option.
Nickname for application
A nickname (up to 8 characters) for the application
you want to run. After creating an icon, the User
Tools window displays the icon with the nickname under it.
Optional Long Name
A descriptive name for the application (up to 29 characters). The long name is informational only; it identifies the application in the dialog box.
Working Directory
The DOS path for the executable. Use this field if the
application you are running does not reside in the
\ELIXIR directory and if you did not specify a DOS
PATH statement for the directory in which the application executable resides.
DOS Application
Select if running a DOS application (enables the
[Command Attributes] options).
Send Only Filename
Uses only the stem name of the file for command
execution.
Prompt for parameters
Select if you want the program to prompt you to enter
an argument that appends to the command in [Command to execute].
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Select to display a dialog box allowing you to enter an
argument when you run the application.
Leave unselected (the default) to run the application
without prompting for an argument.
Run Minimized
Executes the command in a minimized window.
Command is .BAT file
If the command you specify is a DOS batch file:
Select to redisplay the Desktop when you exit the application. Leave unselected to return you to the directory specified in the batch file. If the application is a
batch file that calls another batch file, the Desktop
does not redisplay when you exit the application (see
the “Starting batch files” section in this chapter for
more information).
Pause after execution
Select to pause after exiting the application and to request "press any key to continue" before returning to
the Desktop.
Leave unselected to return to the Desktop after exiting
the application.
Display Options
[Window] displays command execution in a window.
[Full Screen] displays command execution in a full
screen environment.
[Browse] button
Click on to display the contents of a DOS directory
(that you can change) from which you can select a file.
After you specify the required fields in the User Application Setup dialog box and click on [OK], the User
Tools window displays an icon labeled with the nickname you specified in the dialog box and an .XAP extension to identify it as a User Tool icon. The .XAP
file
writes
to
drive:\ELIXIR\DESKTOP\SYSTEM\USERTOOL.
Double-clicking on the icon now runs the specified application described in the following section.
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Starting the application
To start an application for which you have defined an
icon, open the User Tools window and double-click on
the icon.
If you did not select the [Prompt for parameters] option, the Desktop clears and the application starts. If
you selected the above option, a dialog box displays
requesting that you enter an argument. Enter the required argument and click on [OK] to run the
application.
If you selected the [Pause after execution] option, the
program prompts you to" press any key to continue"
after exiting the application. Press any key to return to
the Desktop.
Displaying icon properties
To check or edit the properties of a previouslyspecified application in the User Tools folder, select
the application icon and do one of the following:
Select [Properties] from the File menu.
Select [Tool Props] from the Tools menu on the
User Tools window header.
Press <F2>.
The User Application Setup dialog box displays, showing the information previously specified for the
application.
User Tools example
The following example illustrates how to specify and
run Ventura Publisher from the Desktop, using the
User Tools utility.
Creating an icon for Ventura Publisher
To create an icon for Ventura Publisher, follow these
steps:
1.

Open the User Tools icon.
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The User Tools window displays.
2.

Select [New Tool] from the Tools menu.
The User Application Setup dialog box displays.

3.

Type VP in the [Command to Execute] field.

4.

Type VENT in the [Nickname for application:]
field.

5.

Type Ventura Publisher in the [Optional Long
Name:] field.

6.

Select the [Command is .BAT file] option
(Ventura Publisher runs from VP.BAT, a batch
file).

7.

Do not select [Prompt for parameters].
This starts Ventura Publisher without requiring
you to enter a parameter.

8.

Do not select [Pause after execution].

9.

Enter the directory path that specifies the
location of your Ventura Publisher executable
files.
For example, if the Ventura Publisher batch
(.BAT) file is on the C: (root) drive; enter C:\.

10. Click on [OK].
The User Tools window shows a User Tools icon
with a VENT.XAP label.
Checking the properties of the Ventura Publisher
icon
To check (or modify) Ventura Publisher icon specifications, follow these steps:
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1.

Select the VP icon by clicking on it.

2.

Select [Tool Props] from the Tools menu.
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The User Application dialog box for Ventura Publisher displays. Check the information you entered and make changes if necessary.
3.

Click on [OK].

Starting and exiting Ventura Publisher
To start and exit Ventura Publisher, follow these
steps:
1.

To start Ventura Publisher, open the VENT
icon in the User Tools window.
The Ventura Publisher main screen displays.

2.

Exit Ventura Publisher.
The Desktop redisplays.

Accessing DOS directories
To access directories and files, open the User Files
icon to display the User Files Directory Paths and Tool
Links dialog box. An example shows in the following
figure.
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Figure 8-2. User Files Directory Paths and Tool Links
The User Files Directory Paths and Tool Links dialog
box contains 12 lines on which you can specify up to
12 DOS directory paths. Select any line and click on
[OK] to display a window showing the contents of the
directory specified on the line. The following figure
shows a window example. You can also use wildcard
characters to display a filtered list of files in a
directory.

Figure 8-3. Window example
If you enter a directory that does not exist, a dialog
box displays to confirm creating a new directory.
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Changing directories
The window header contains a backup button similar
to the button described in the “Elixir folders” chapter.
Click on the backup button to display the contents of
the directory one level closer to the root directory. Repeatedly clicking on the backup button eventually displays a window showing the active drives on your PC.
For example, if you have the C:\TYPESET\LETTERS
window displayed and you repeatedly click on the
backup button, the following windows display after
each click:
C:\TYPESET
C:\ (the root directory)
Active drive letters (C:, A:, etc.)
To change directories further from the root, click on
any folder icon (<Dir>) to display the contents of the
folder (directory).
Copying files between subdirectories
To copy one or more files to another subdirectory, follow these steps:
1.

Select and drag the file(s) to the User Files
icon.
The User Files Directory Paths and Tool Links
dialog box displays with the path for your specified file(s) selected.

2.

In the dialog box, enter the full path for the
directory to which you want to copy the file(s),
or select the path if it already displays.

3.

Click on [OK].

The file(s) you selected copy to the directory you
specified.
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Linking files to applications
When you establish a link between an application and
a file, double-clicking on the file icon starts the application and loads the file as a parameter to the application command (you can link only one application to
one or more files in a directory).
The Tools menu (accessed from the header of any
open window displayed through the User Files icon)
allows you to establish links between files in a window
and an application (executable or batch file).
For example, if you link files created by a word processing program to the word processing application,
double-clicking on any of the file icons starts the word
processing program and loads the selected file in the
program.
You can link files to an application for which a User
Tool is already defined, or create a User Tool for an
application and link files to it.
Linking files to an already-defined User Tool
If you created a User Tool icon for an application, you
link files in a directory to the application as follows:
Select [Tool Link] from the Tools menu to display the
Tool Link Definition dialog box shown in the following
figure.

Figure 8-4. Tool Link Definition dialog box
The Tool Link Definition dialog box displays the following options:
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UserTool Nickname
Enter the nickname you specified when creating the
user tool. Using the User Tools example in the previous section, you would enter VENT for Ventura
Publisher.
Open only files with extension
Select to only link files with the extension you specify.
Leave unselected (the default) to not use an extension
filter. Files with all extensions link to the application.
Linking files to a new application
If you have not established an application as a User
Tool icon, you can do so by selecting [New Tool] in
the Tool Link Definition dialog box header to display
the User Application Setup dialog box.
See the “Creating an application icon” section in this
chapter for more information about fields in this dialog
box.
Checking tool properties
After you establish tool links, you can check or modify
entries for the Tool Properties from the Tools menu.
Selecting this option displays the User Application
Setup dialog box for editing.
Opening linked files
When files in a directory link to an application, doubleclicking on a linked file starts the application and loads
the file in the application.
If you selected [Prompt for parameters] in the User
Application Setup dialog box, the Arguments to this
program dialog box shown in the following figure
displays.
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Figure 8-5. Arguments to this program dialog box
The parameter (file name) shown in the dialog box is
the file name last entered. (The example has no previously entered file name.)
Starting DOS executables
Double-clicking on a .EXE, .COM, or .BAT file
prompts you for an argument (file name) for the executable. If required, enter an argument, or just click
on [OK] to start the executable.
Starting batch files
When you start a DOS batch file (.BAT) using the
User Tools icon, the Elixir Desktop loads an additional
COMMAND.COM program in system memory to enable returning to the Desktop. The size of the program file is about 11 KB.
If the batch file you want to start from the Desktop requires a major portion of available memory, the additional COMMAND.COM file may not leave enough
memory to run your batch file (for example, a Ventura
Publisher chapter that contains many fonts and paragraph tags consumes much memory).
To utilize the maximum amount of system memory,
start batch files in one of the following ways:
If possible, start the application directly without
using a batch file.
Do not select the [Command is .BAT File] option
in the User Application Setup dialog box and use
an ASCII editor to add the following lines to the
end of the batch file:
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drive:
CD \ELIXIR
ELIXIR
drive: is the drive on which the Desktop installs.
Use a commercially-available memory management program to remove unwanted memoryresident programs from memory. Add the command(s) required to remove the additional
COMMAND.COM program to the first line of your
application batch file. Select the [Command is
.BAT File] option in the User Application Setup
dialog box.

Using the Dispatcher icon
The Dispatcher icon allows you to specify up to 12
DOS commands with optional embedded replaceable
parameters. Copying a file to the Dispatcher icon
substitutes the name of the file for the replaceable parameter and invokes the command.
The Dispatcher icon provides a convenient way to
store commonly-used DOS commands, that you start
using simple mouse operations.
Some examples of functions you can store and run
using the Dispatcher icon are:
DOS batch files
Elixir utilities or batch files
Quick DOS
optimizer).

operations

(such

as

the

disk

You can use the Dispatcher icon in the following ways:
Copy one or more files to the Dispatcher icon and
in the displayed dialog box select the batch command you want to run with the selected file(s) as
replaceable parameter(s).
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Open the Dispatcher icon, enter a batch command, and enter the name of the file you want to
run as a parameter to the batch command.
Setting up Dispatcher commands
To set up Dispatcher commands, open the Dispatcher
icon to display the Dispatcher Commands dialog box
shown in the following figure.

Figure 8-6. Dispatcher Commands dialog
box example
The dialog box allows you to enter and display up to
12 DOS commands.
To enter a command, select a line and type the
command.
You can use a %1 replaceable parameter in the command line. When you copy a file to the Dispatcher
icon and select the command line, the file name substitutes for the replaceable parameter.
If you want a prompt to enter a parameter each time
you run the Dispatcher command, select the [Prompt
for parameters] option in the User Application Setup
dialog box. The parameter you specify adds after the
Dispatcher command.
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Use the <Backspace>, <Del>, and horizontal arrow
keys to edit a selected line.
If you frequently run more than 12 Dispatcher executables, you may want to store eleven of your most
frequently-used commands and leave one line open to
enter other commands as required.
After entering a command, select [Setup] in the dialog
box header to display the User Application Setup dialog box shown in the following figure.

Figure 8-7. User Application Setup dialog box
The User Application Setup dialog box shows the
command you entered in the [Command to Execute]
option (you can edit the command, if required).
The User Application Setup dialog box displays the
following options:
Command to Execute
The command you want to execute through the
Dispatcher.
Nickname/Optional Long Name
Not applicable when setting
executables.
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Working Directory
Optional - allows you to enter the path of the directory
containing the executable (useful if the executable you
are running is does not reside on drive:\ELIXIR and
you did not specify a DOS PATH= statement).
DOS application
Select if you want to specify a DOS application (enables the [Command Attributes] options).
Send Only Filename
Execution of this command uses only the stem name
of the file.
Prompt for parameters
Select to prompt for an argument when executing the
command (see the description for the Dispatcher
Commands dialog box). This allows you to run commands directly from the Dispatcher icon without requiring you to copy files to the Dispatcher icon.
Run Minimized
Executes the command in a minimized window.
Command is .BAT file
For a batch (.BAT) file, select to return you to the
Desktop after executing the command. Leave unselected (the default) to return you to DOS after executing the command. If the executable is a batch file that
calls another batch file, you return to the second batch
file.
Pause after execution
Select to pause after command execution and to
prompt for any keystroke to continue (redisplays the
Desktop). Otherwise redisplays the Desktop immediately after command execution.
Display Options
[Window] displays command execution in a window.
[Full Screen] displays command execution in a full
screen environment.
After specifying options, click on [OK] to redisplay the
Dispatcher Commands dialog box. Click on:
[Start] to execute the highlighted command
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[OK] to update information in the dialog box without executing any commands
[Cancel] to cancel any changes to the Dispatcher
Command dialog box.
Executing Dispatcher commands
You can run DOS command files using the Dispatcher
in two ways:
by copying selected files to the Dispatcher icon
by opening the Dispatcher icon and executing
commands.
Copying files to the Dispatcher
To execute Dispatcher commands by copying one or
more files to the Dispatcher icon, follow these steps:
1.

Select one or more files.

2.

Copy the selected files to the Dispatcher icon
using any copy procedure, or press <Ctrl> +
<I>, or select [Dispatch] from the File menu.
The Dispatcher Commands dialog box displays.

3.

Select the command line for the command
you want to execute, or enter or modify a
command on any line.

4.

Click on [Start].

The Desktop clears, and the command executes multiple times, each time with one file as an argument to
the command.
Executing commands from the Dispatcher icon
To execute a command and specify a parameter to
the command directly from the Dispatcher icon, follow
these steps:
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1.

Open the Dispatcher icon (double-click on it,
select it and press <Enter>, or just press
<Ctrl> + <I>).
The Dispatcher Commands dialog box displays.

2.

Select the command you want to execute.

3.

Click on [Setup].
The User Application Setup dialog box displays.

4.

Select [Prompt for parameters].

5.

Click on [OK].
The Dispatcher dialog box redisplays.

6.

Click on [Start].
The Arguments to this program dialog box
displays.

7.

Enter any parameter(s) required to execute
the command.

8.

Click on [OK].
The command executes with the parameter you
specified.

Dispatcher example
The following example shows how you can use the
Dispatcher icon to issue a DOS TYPE command to
view the contents of an ASCII file. This example assumes that your AUTOEXEC.BAT file is on your C:
drive.
1.

Open the Dispatcher icon.
The Dispatcher Commands dialog box displays.

2.

On a blank line, enter TYPE %1 | MORE and
click on [Setup].
This DOS command lists the contents of an ASCII file one screen at a time and then pauses and
prompts you to enter any key to continue.
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3.

In the displayed User Application Setup dialog
box select the following options:
[DOS application]
[Pause after execution]
[Full Screen].
Click on [OK] twice to exit the Setup and Dispatcher Commands dialog boxes.

4.

Open the User Files icon.

5.

On the displayed User Files Directory Paths
and Tool Links dialog box, enter C:\*.* on a
blank line and click on [OK].
A window displays the contents of the C: drive on
your PC.

6.

In the window header, select [By Name] from
the View menu.
The contents of your C: drive displays in alphabetical order.

7.

Select the AUTOEXEC.BAT file and copy it to
the Dispatcher icon.

8.

In the displayed Dispatcher Commands dialog
box, select the TYPE %1 | MORE line and click
on [START].
The screen clears and the contents of your
AUTOEXEC.BAT file displays followed by a
“Press any key to continue” message. Press any
key to redisplay the Desktop.
After specifying the DOS TYPE command in the
Dispatcher Commands menu, you can use the
procedure above to list the contents of any ASCII
file from the Desktop.
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Using the Dispatcher to run Elixir utilities
You can run DOS-based Elixir utilities from the Desktop in several ways (for example, by using the DOS
menu). However, the Dispatcher allows you to conveniently run the utilities by copying files to the Dispatcher icon and specifying the commands required to
run the utilities in the Dispatcher Commands dialog
box. The following figure shows an example of a dialog box with commands for some Elixir utilities.

Figure 8-8. Dispatcher Commands dialog
box example
You must install Elixir utilities in the drive:\ELIXIR directory. Unless you have included drive:\ELIXIR in a
DOS PATH= statement, either precede each command shown in the example with drive:\ELIXIR or
specify drive:\ELIXIR for [Full path to executable for
optional lookup] in the User Application Setup dialog
box.
Some Elixir utilities require that you specify the stem
name (file name without the extension) of the file as a
parameter. To use the Dispatcher for such utilities,
select the [Usage Switches] option from the System
menu and from the displayed dialog box and select
the [Send Only Filename on Dispatches] option.
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DOS menu
The DOS menu allows you to enter any DOS command from the Desktop.
Pull down the DOS menu and select [DOS Command], the only option.
Alternatively, enter <Ctrl> + <D> at the keyboard.
The DOS Commands dialog box shown in the following figure displays.
Enter any DOS command and click on [OK] to execute the command.
The DOS command you enter executes from the directory corresponding to the top window on the Desktop. If no windows are open, the command executes
from the root directory (for example, C:\).

Figure 8-9. DOS Commands dialog box
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Stand-alone utilities

This chapter describes the stand-alone batch utilities
provided with your Desktop. These utilities copy to the
drive:\ELIXIR directory during software instal- lation.
Each time you install or reinstall the Desktop, you
overwrite the existing utilities with new ones. If you
want to keep older utility versions, you must back up
the .EXE and .COM files in your drive:\ELIXIR directory before installation.
The examples used in this chapter assume that you
have installed both the Elixir Desktop program and
data files in the drive:\ELIXIR subdirectory. If you installed these files in a custom subdirectory, substitute
the name of that directory for drive:\ELIXIR in all
cases.

Using the utilities
The parameters required to run each utility display on
your screen when you enter the utility name from the
drive:\ELIXIR directory.
Most utilities accept DOS wildcard characters (see
your DOS documentation for instructions). When using wildcards, specify only the desired file(s).
For optional utility parameters enclosed in brackets [],
either enter the appropriate parameters for the option
(as described in the Usage section of the utility) or
leave blank to accept the default (the default is the
first in the list following the parameter).
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When specifying utilities, either do not specify parameters (to use the default for each parameter) or
specify all the parameters. You cannot skip parameters.
All utilities tie into Desktop operations through dialog
boxes (although not all utility options are available
from the Desktop dialog boxes). You must run application-specific utilities from either the Dispatcher
icon or the DOS menu command line. See the "Accessing DOS files and applications" chapter for more
information.
Add drive:\ELIXIR to the DOS PATH= statement in
your AUTOEXEC.BAT file to ensure that DOS
searches the drive:\ELIXIR directory for the batch utility. See your DOS manual for more information.

DISP
The DISP utility displays the contents of a file on your
screen in hexadecimal, ASCII, and screen character
format. This information is helpful for debugging files.
Usage

DISP filename [count][pausing] <Enter>
filename
is any file name, including path and extension.
count
is the number of characters displayed per line. The
default is 15.
pausing
specify whether or not to pause after displaying a
screen of data: PAUSE or NOPAUSE.

Directory
information
Example

Run DISP from the drive:\ELIXIR directory, if you have
not specified drive:\ELIXIR in your DOS PATH=
statement.
To display the contents of the file NEW.FNT in the
drive:\ELIXIR\FONTS\X97OUT directory, type:

CD \ELIXIR <Enter>
9-2
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The current directory changes to \ELIXIR.

DISPdrive:\ELIXIR\FONTS\X97OUT\NEW.FNT
<Enter>
The contents of NEW.FNT displays.

ELXINV
The ELXINV utility converts portrait or landscape
forms to inverse portrait or inverse landscape forms.
For correct form conversion, the ELXINV utility must
have access to an ASCII file containing the following
information:
the names of the regular orientation (portrait or
landscape) fonts and graphics the form uses.
the names of the inverse (portrait or landscape)
fonts and rotated graphics (in ElixiGraphics) to be
used when building the inverse version of the
form.
You must rotate graphics 180-degrees (using ElixiGraphics), and they cannot be inverse version
graphics.
See the ElixiFont Edition User Guide for information
on rotating fonts and changing headers to create inverse fonts.
Use any text editor to create an ASCII file named
INVFONTS.LST and specify the above information in
the file as follows:
1.

On the first line, type the stem name of the
regular orientation font or graphics file, a
space, and the name of the inverse orientation
version of the same font or graphic.

2.

Press <Enter>.
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Repeat this process until you specify the
regular and inverse orientation names for all
fonts and graphics the form uses.

Usage

3.

Save the file as
INVFONTS.LST.

an

ASCII

file

named

4.

Place the file in the \ELIXIR directory on the
drive on which your Elixir software resides.

ELXINV filename1 [filename2] <Enter>
filename1
is any DOS .ELX file name, including the extension.
Wildcards are permissible, but ensure that the forms
specified have the same orientation and page size.
filename2
is the output file name (optional).
If you did not specify an output file name, ELXINV creates a file named FILENAME1.INV. Note that to print
or edit the output file, you must first rename it to a file
with an .ELX extension.
If you run ELXINV and the fonts or graphics in the portrait or landscape form are not in the INVFONTS.LST
file list, substitutions do not generate for fonts or
graphics.

Directory
information

Example

Run ELXINV from the directory in which the files to be
converted reside.
If you have not specified
drive:\ELIXIR in a DOS PATH= statement, precede
the ELXINV command with drive:\ELIXIR.
To convert a form file, type:

CD \ELIXIR\FORMS\ELIXIR <Enter>
The
current
directory
changes
to
drive:\ELIXIR\FORMS\ELIXIR, that contains output
form files.
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drive:\ELIXIR\ELXINV TEST.ELX OPFILE.ELX
<Enter>
ELXINV
converts
TEST.ELX
in
the
drive:\ELIXIR\FORMS\ELIXIR directory to inverse orientation and writes it to the
OPFILE.ELX file.

ELXWDATA
ELXWDATA generates a text file called
ELXWDATA.TXT on the floppy diskette in the A:
drive. The file contains configuration information
about your PC and Elixir installation and is useful for
debugging. If you have problems running Elixir, customer support staff may instruct you to run this utility
and forward the diskette containing ELXWDATA.TXT
to the customer support center.
Usage
Directory
information

ELXWDATA <Enter>
Run ELXWDATA from the drive:\ELIXIR directory.

FONTCHG
The FONTCHG utility does the following:
Strips the two left characters from Elixir-format
form files names when you enter only a filename.
Substitutes fonts in an Elixir form with fonts you
specify in a font list when you enter a filename
and use the fontlist parameter.
Lists information about fonts in an Elixir-format
form when you enter a filename and use the
-LIST parameter.
Usage

FONTCHG filename [fontlist][-LIST]<Enter>
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filename
is the Elixir-format form file name, with or without the
.ELX extension. Wildcards are permissible.
fontlist
is the full name and path of an ASCII font list file with
a .LST extension. Wildcards are not permissible.
Each line of the font list file contains a pair of Elixir
fonts separated by a space. When running the utility,
fonts in the first column become substituted with the
corresponding font from the second column.
-LIST
just displays a list of .ELX files specified by filename,
and for each .ELX file, lists the fonts used in the form.
A list of all fonts used in multiple forms (when using
wildcards for filename) also displays.
Directory
information

Example

Run FONTCHG from the directory in which the files to
be converted reside. If you have not specified
drive:\ELIXIR in you DOS PATH= statement, precede
the FONTCHG command with drive:\ELIXIR.
To substitute fonts in the Elixir form TEST.ELX with
the fonts in the FIRST.LST ASCII font list file, type:

CD \ELIXIR\FORMS\ELIXIR <Enter>
The current directory (on the current drive)
changes to \ELIXIR\FORMS\ELIXIR.

FONTCHG TEST.ELX FIRST.LST<Enter>
This command substitutes the fonts in the Elixir form
TEST.ELX with the fonts specified in the ASCII font
list file FIRST.LST in the \ELIXIR\FORMS\ELIXIR directory of the current drive.
The file FIRST.LST contains two columns of font
names; the fonts used in the form TEST.ELX are in
the first column, and each one becomes replaced by
its corresponding font from the second column.
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FONTMAP
The FONTMAP utility is a transformer that automatically remaps font characters based upon the hexadecimal position mapping specified in a .GMP file. The
.GMP file has A1=ED type entries where A1 is the
source font character position, and ED is the new
character position in the target font.
The Efont Factory uses FONTMAP to remap the fonts
for ISO XB and FULL mapping. You can edit existing
ISO_XB.GMP or FULL.GMP files so they generate
customized fonts with national characters in different
positions.
You can also use FONTMAP to remap or prune fonts
by omitting entries in the .GMP file so that no character maps in the new font. FONTMAP functions with
Elixir-format fonts, so you can remap fonts for any
printer format.
FONTMAP replaces the MAPPING.MAP facility, and
is useful for automatically remapping characters in a
large number of fonts, or for splitting fonts in two.
Usage

FONTMAP sourcefont file targetfont file
fontmapfile
sourcefontfile
is the name of the Elixir font file in the
drive:\ELIXIR\FONTS\ELIXIR directory from which to
extract the character bitmaps for remapping.
targetfontfile
is the name of the target Elixir font file in the
drive:\ELIXIR\FONTS\ELIXIR directory to which the
character bitmaps from the source font file are
remapped.
fontmapfile
is the name of the .GMP font map file in the
drive:\ELIXIR\FONTS\MAPS directory that contains a
hexadecimal position remapping for the source and
target font files.
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Directory
information

Example

Run FONTMAP from the directory in which the files to
be transformed reside. If you have not specified
drive:\ELIXIR in a DOS PATH= statement, precede
the FONTMAP command with drive:\ELIXIR.
To remap the characters from the HE11BP.HDR font
file in the drive:\ELIXIR\FONTS\ELIXIR directory to
the
PL11OE.HDR
font
file
in
the
drive:\ELIXIR\FONTS\ELIXIR directory using the
CP_852CD.GMP file (included with the software) in
the drive:\ELIXIR\FONTS\MAPS directory, type:

CD \ELIXIR\FONTS\ELIXIR <Enter>
The current directory changes to the directory in
where Elixir font files reside.

FONTMAP HE11BP.HDR PL11OE.HDR
CP_852CD.GMP<Enter>
This command remaps the character bitmaps in the
HE11BP.HDR file to the PL110E.HDR file using the
hexadecimal position remapping information found in
the CP_852CD.GMP file.

FORMPRN
The FORMPRN utility prints Elixir format forms in
batch mode using MS-DOS commands.
Usage

FORMPRN [path]filename [HP]
[printer/disk] [copies] [ASCII] [macronumber]
[traynumber] [LPT1/LPT2/LPT3]
[interword/interchar] [once/never]
[Xshift/Yshift] <Enter>
path
is the optional DOS pathname
filename
is any DOS file name, including the file extension.
Wildcards are permissible.
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HP
is the attached proof printer. The output files have
.PRN extensions.
printer/disk
is the destination of the output file, to a printer (default) or to a hard disk or diskette: PRINTER or DISK.
copies
is the number of copies you want to print. The default
is 1. Note that font files accompany every copy.
ASCII
for locally attached proof printers.
macro number
is the macro number used for HP printers. 0 = None.
tray number
is the output tray number for printers supporting this
feature. The default tray is 0.
LPT!/LPT2/LPT3
is the printer number to use (default is LPT1).
interword/interchar
is interword (default) or intercharacter spacing.
once/never
for downloading fonts once (default) or never.
Xshift
is the horizontal amount to shift the page.
Yshift
is the vertical amount to shift the page.
Directory
information

Run FORMPRN from the drive:\ELIXIR directory.
FORMPRN searches the default forms directory (usually drive:\ELIXIR\FORMS\ELIXIR\DEMO) as specified in the ElixiForm configuration file.
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FSIMG
The FSIMG utility converts .LP3, .PCX, and .TIF format graphics files to .LP3, .PCX, screen, or .TIF format files.
Usage

FSIMG stemname [infileformat]
[outfileformat] [outputdevice]
[monitor] [tempdir] [conversiontype]
[color] [planes] <Enter>
stemname
is any DOS stem name. No file extensions or wildcards are permissible.
infileformat
Valid values for the input format parameter are L , P,
and T as follows:

L

represents Elixir (.LP3) format graphics files.
To convert an Elixir graphics file, it must be in
the drive:\ELIXIR\PICS\PRINTER directory.

P

represents color or non-color .PCX format files.
To convert a .PCX file, it must be in the
drive:\ELIXIR\PICS\PCXIN directory.

T

represents color or non-color TIFF (.TIF) format
files. To convert a TIFF format file, the file must
be in the drive:\ELIXIR\PICS\TIFFIN directory.
outfileformat
Valid values for the output format parameter are L, P,
8, and T as follows:
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L

creates an output graphics in Elixir (.LP3)
graphics format. The output .LP3 file writes to
the drive:\ELIXIR\PICS\PRINTER directory. A
screen version (.LW8) of the file is also created
in the drive:\ELIXIR\PICS\SCREEN directory.

P

creates a .PCX format graphics file
thedrive:\ELIXIR\PICS\PCXOUT directory.

in
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8

creates Elixir screen format (.LW8) versions of
a graphics file that work with the graphics in
ElixirForm. The output file generates in the
drive:\ELIXIR\PICS\SCREEN directory.

T

creates TIFF (.TIF) format files in the
drive:\ELIXIR\PICS\TIFFOUT directory.
outputdevice
applies only to DISK output format files.
monitor
allows you to specify your monitor as one of the following: VGA, SIGMA, WYSE, SUPERVGA, or NONE.
tempdir
is the directory in which temporary read/write operations take place. You may want to specify a RAM
drive for faster file conversion.
conversiontype
is the conversion type, when converting .PCX or .TIF
files. PR (the most frequently used) specifies Presentation conversion used for graphics, line art, and
graphics without gray scales. PI signifies Pictorial
conversion, used when converting high-grade graphics such as scanned photographs or graphics with
gray scales.
color
is the output color: RED, GREEN, BLUE, or FULL.
planes
specify 1 for black-and-white graphics, 2 for two-plane
highlight color graphics, or 3 for full color graphics
(when converting to and from Elixir-format (.LP3)
graphics).

Directory
information

Example

The current directory changes to drive:\ELIXIR to run
FSIMG unless you have included drive:\ELIXIR in a
DOS PATH= statement.
To convert a color 300 dpi .TIF file named PIC1.TIF to
a color .PCX (and to create a screen version for a
VGA monitor), type:

C: <Enter>
ELIXIR FORMS EDITOR DESKTOP USER GUIDE
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CD \ELIXIR <Enter>
FSIMG PIC1 T P VGA PI<Enter>
The output color PIC1.PCX writes
drive:\ELIXIR\PICS\PCXOUT directory.

to

the

HPEDIT
The HPEDIT utility allows editing of PCL font files.
Usage

HPEDIT filename [SYMBOL=]
[POINT] [STYLE] [WEIGHT] [TYPEFACE]
<Enter>
filename
is the file name or filepath of the source font. Wild
cards are allowed.
symbol=
where symbol set
1 = ROMAN-8, 2 = PC-8,
3 = PC-8 (D/N), 4 = ISO.
point=
is the point size in tenths.
style=
where style 1 = UPRIGHT, 2 = ITALIC
weight
is the strokeweight between -7 and 7.
typeface
iwhere typeface is one of the following letters:
A) Presentations
B) Cooper Black
C) Courier
D) Palantino
E) Elixir
F) Black Bondini Condensed
G) Letter Gothic
H)Helvetica
I) ITC Garamond
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J) Gothic
K) Micrographics
L) Line Printer
M) Swiss Condensed
N)Coronet Bold
O) Optima
P) Prestige
Q) Zaph Dingbats
R) Broadway
S) Century Schoolbook
T) Time Roman
U) University Roman
V) Avante Garde
W) Futura
Z) Zorich Roman
Directory
information

Run HPEDIT from the drive:/ELIXIR directory using
the desktop dispatcher or at the DOS prompt.

IC
The IC utility converts graphic formats.
Usage

IC sourcefile [in format]
[out format] [-options] <Enter>
sourcefile
is the file name or filepath of the source image. Wild
cards are allowed.
in format
is the name of the source image format (Elixir, Pseg,
PCX, TIF).
out format
is the name of the target image format (Elixir, Pseg,
GOCAPSEG, PCX, TIF, Screen).
-Caaa
is the name of color or color id.
1=Blue, 2=Red, 3=Pink, 4=Green, 5=Cyan, 6=Yellow
Default: 0=Presentation process default
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-Dnnn
is the output resolution in dpi (240 or 300).
-Faaa
is the record format for output options(VBM, AS400,
IRMA, OS2, MODCA)
-Wa
is the selection for removinf white space.
N=white space not removed
Y=white space removed
-Rnnn
is the selection to rotate pages in degrees.
-Xnnn
is the horizontal offset in pels.
-Ynnn
is the vertical offset in pels.
-Saaa
is the selction for monitor type (VGA, SuperVGA,
Sigma, WYSE).
Directory
information

Run IC from the drive:/ELIXIR directory using the
desktop dispatcher or at the DOS prompt.

LP32ELX
The LP32ELX utility converts Elixir-format graphics
(.LP3) files to Elixir format font (.HDR) files.
Usage

LP32ELX filename.LP3 [retile] [orientation]
<Enter>
filename.LP3
is the Elixir-format graphics file for conversion, including the .LP3 extension. Wildcards are permissible.
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retile
specify whether the .TXT file associated with the .LP3
file is to be retiled: YES (the default) or NO.
orientation
specify the orientation of the font creation as portrait,
landscape, inverse portrait, or inverse landscape:
PORT, LAND, INVPORTRAIT, or INVLANDSCAPE.
Directory
information
Example

Run LP32ELX from the drive:\ELIXIR\PICS\PRINTER
directory.
The output file writes to the
drive:\ELIXIR\FONTS\ELIXIR directory.
To
convert
PICT.LP3
in
the
drive:
\ELIXIR\PICS\PRINTER directory to an Elixir font file
in drive:\ELIXIR\FONTS\ELIXIR and to retile the .TXT
file, type:

CD \ELIXIR\PICS\PRINTER <Enter>
LP32ELX PICT.LP3 YES <Enter>

SHOWBLOK
The SHOWBLOK utility displays information about any
ElixiKeys attached to your PC and your authorization
to run Elixir applications.
Usage
Directory
information

Example

SHOWBLOK <Enter>

Run SHOWBLOK from the \ELIXIR directory. If you
have not specified drive:\ELIXIR in your DOS PATH=
statement, precede the SHOWBLOK command with
drive:\ELIXIR.
To use SHOWBLOK to determine the ElixiKeys present on your PC, change the current directory to drive:
then type:

CD \ELIXIR <Enter>
The current directory changes to drive:\ELIXIR.

SHOWBLOK <Enter>
ELIXIR FORMS EDITOR DESKTOP USER GUIDE
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If you installed the ElixirFont and ElixirGraphics applications and keys on your PC, a message similar to the following displays on your
screen:
ELIXIFONT BLOCK PRESENT
ELIXIGRAPHICS BLOCK PRESENT

SHOWELX
The SHOWELX utility displays the contents of an
Elixir form file and the elements comprising the form:
the font list, boxes, lines, graphics, and text strings.
The contents display on the screen and you can redirect the output to a file for printing.
Usage

SHOWELX filename <Enter>
filename
is the DOS form file name including the .ELX extension. Wildcards are permissible.

Directory
information

Example

Run SHOWELX from the directory in which the filename resides. If you have not specified drive:\ELIXIR
in a DOS PATH= statement, precede the SHOWELX
command with drive:\ELIXIR.
To display the contents of a form named
BBPLAY3.ELX in the drive:\ELIXIR\FORMS\ELIXIR
directory, type:

CD \ELIXIR\FORMS\ELIXIR\ <Enter>
The
current
directory
changes
drive:\ELIXIR\FORMS\ELIXIR\DEMO.

to

\ELIXIR\SHOWELX BBPLAY
ELX <Enter>

9-16

ELIXIR TECHNOLOGIES CORPORATION

STAND-ALONE UTILITIES

This displays the contents of and the elements comprising the BBPLAY3.ELX form. Press <Ctrl> + <S>
to stop screen scrolling, or use the DOS MORE command to display one screen at a time as follows:

SHOWELX filename | MORE <Enter>
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Keyboard shortcuts

This appendix lists all keyboard shortcuts for Desktop
operations and for child window menus.

Desktop
Close dialog box/menu

<Esc>

Organization of the following Desktop keyboard shortcuts is by pull-down menu.
File menu

<Alt> + <F>

Close (top window)

<F3>

Convert

<Ctrl> + <V>

Copy to

<Ctrl> + <C>

Copy quit

<Esc>

Delete

<Del>

Dispatch

<Ctrl> + <I>

Exit

<Alt> + <F4>

Help

<F1>

Open

<Enter>

Print

<Ctrl> + <P>

Properties

<F2>
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System menu

<Alt> + <S>

System Configuration

<Alt> + <F6>

Diagnostics

<Alt> + <F5>

Make Directory

<Ctrl> + <M>

Special menu

<Alt> + <P>

Close All

<F4>

Efont Factory

<Alt> + <E>

Scheduler Action

<Alt> + <F3>

Scheduler Setup

<Alt> + <F2>

DOS menu

<Alt> + <D>

DOS command

<Ctrl> + <D>

Window menu

<Alt> + <W>

Help menu

<Alt> + <H>

Contents

<F1>

Back up one directory level

<Ctrl> + <B>

Display start of file list

<Home>

Display end of file list

<End>

Windows
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Display next page

<Page Down>

Display previous page

<Page Up>

Filter menu

<Alt> + <I>

Jump to files beginning with
letter...

press <letter>

Reselect

<Ctrl> + <R>

Select adjacent file

Left/Right/Up/Down
arrow keys

Select/Unselect All

<Ctrl> + <A>

Write Selections

<Ctrl> + <W>

By option name
Back up one directory level

<Ctrl> + <B>

Close top window

<F3>

Close All

<F4>

Close dialog box/menu

<Esc>

Convert

<Ctrl> + <V>

Copy to

<Ctrl> + <C>

Delete

<Del>

Diagnostics

<Alt> + <F5>

Dispatch

<Ctrl> + <I>

Display start of file list

<Home>

Display end of file list

<End>

Display next page

<Page Down>

ELIXIR FORMS EDITOR DESKTOP USER GUIDE

A-3

KEYBOARD SHORTCUTS

A-4

Display previous page

<Page Up>

DOS

<Ctrl> + <D>

Exit Elixir

<Alt> + <F4>

Filter menu

<Alt> + <I>

Help

<F1>

Jump to files beginning with
letter...

press <letter>

Make PubFile

<Ctrl> + <U>

Open

<Enter>

Print

<Ctrl> + <P>

Properties

<F2>

Reselect

<Ctrl> + <R>

Select adjacent file

Left/Right/Up/Down
arrow keys

Select All

<Alt> + <A>

Scheduler Action

<Alt> + <F3>

Scheduler Setup

<Alt> + <F2>

System Config

<Ctrl> + <F6>

Unselect All

<Ctrl> + <A>

Write Selections

<Ctrl> + <W>
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Additional files and
directories

This appendix describes additional files and directories the Elixir Desktop uses.

Elixir mapping table directories
This section describes directories that contain mapping or correspondence tables. You can access these
directories using the User Files icon described in the
“Accessing DOS files and applications” chapter.
PostScript mapping table directory
The
PostScript
mapping
table
directory
(drive:\ELIXIR\PSSTASH) contains the following mapping tables:
PSFONT.MAP
An ASCII file in which each line consists of the sixcharacter Xerox production printer font file name, an
equal sign (=), and the PostScript equivalent ElixiScript uses.
PSTOP.PSC
This ASCII file contains macros and job setup commands and is added as a header to each PostScript
job. This file also allows access to international
characters.
PSEND.PSC
The PostScript page terminator code (such as footers,
line draw, page markers, and page eject) in ASCII
format.
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PSTRAIL.PSC
This file is appended to the end of multi-page PostScript jobs (status sheet).
See the “File conversions” chapter for more information about PostScript processing.
Contour fonts mapping table directory
The contour fonts mapping table directory,
drive:\ELIXIR\FONTS\TABLES, contains the .TFB file
created when you do not select [Keep Left Kern] in the
Outline-to-raster font generator dialog box (see the
“Accessing DOS files and applications” chapter for
more information).
Bitstream Facelift fonts mapping directory
The Bitstream Facelift fonts mapping directory,
drive:\ELIXIR\FONTS\MAPS,
contains
the
BTFONTS.NAM and BTFONTS.MAP files.
BTFONTS.NAM
Contains an ASCII list with the following information
for each font: the .TDF font file name, the twocharacter font family designator, and the typestyle.
BTFONTS.MAP
Contains a table that maps the name of a new Bitstream Facelift font to the name of a PostScript font
on a printer.
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The Elixir Desktop
menu bar

This appendix describes or refers you to the options
and corresponding keyboard shortcuts (fast keys)
available from the Desktop pull-down menus.

Figure C-1. Desktop menu bar

File menu
The File menu options perform operations on files,
applications, or attached devices (printers, scanners,
and diskette). The following figure shows the File
menu.

Figure C-2. File Menu
The File menu contains the following options:
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Open (<F2>)
Opens a selected icon as does double-clicking on an
icon. Opening an icon has different meanings, depending on whether the icon is a folder, Elixir file,
Elixir application, User Tool, peripheral device, or icon,
as follows:
When you open a folder, a window displays showing
the contents of the folder. A folder may contain files
and additional folders. Each folder corresponds to a
DOS directory.
When you open an Elixir-format file, the Elixir
Desktop runs the Elixir application associated
with the file. For example, if you open an Elixir
form file, Elixir Forms Editor runs and loads the
form file you selected.
When you exit the Elixir application, the Elixir
Desktop redisplays.
Opening an application icon clears the Desktop
and runs the application. When you exit the application, the Elixir Desktop redisplays.
When you open the Diskette, Dispatcher, or
Scanners icon, a Properties dialog box displays,
allowing you to set specifications and properties
for these items.
Copy (<Ctrl> + <C>)
Copies a selected file or files to another folder or icon.
When you select this option, the screen pointer
changes to a small document icon attached to an uparrow. To copy the file, click on the folder icon into
which you want to copy the file, as follows:
If copying to an Elixir folder (the Forms, Fonts,
Graphics, or Documents folder icons on the top
left of the Desktop), click on the appropriate Elixir
folder, on an Input, Output, or Elixir folder, and finally on the destination folder.
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If copying to a non-Elixir folder, click on the User
Files icon to display the User Files Directory
Paths dialog box. In the dialog box, specify the
directory into which you want to copy the file and
click on [OK].
For information on copying files to and from diskettes
and tapes, see the “Peripheral devices” and “Desktop
basics” chapters.
New
Creates a new file in a window folder. A dialog box
displays in which you enter the name and extension of
the new file.
If you create an Elixir-format file in an Elixir folder, you
do not need to specify an extension because the Elixir
Desktop creates files with the appropriate extensions.
When you create a new Elixir font, you generate all
three component files.
When you create a new file in the Elixir Documents
folder, you generate a .DAT file with a sample (blank)
form.
Duplicate
Creates a duplicate of a selected file in the same
folder. A dialog box displays and prompts you to enter
a name for the duplicate file.
If you duplicate a file in any of the Elixir folders and do
not specify an extension for the [into] option, the extension appropriate for that folder generates.
Delete (<Del>)
Deletes selected files and empty folders (you cannot
delete a folder that contains files or other folders).
If [Confirm File Deletions] is selected (in the Desktop
Usage Switch Settings dialog box accessed from the
System menu), a confirmation prompt displays, showing the name of the file.
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Properties (<F2>)
Allows you to view or set specifications in dialog
boxes for files, the System Diskette, the converter,
dispatcher, and attached scanners and printers.
Selecting properties for the Diskette icon displays
the System Diskette dialog box described in the
“Desktop basics,” and “Peripheral devices”
chapters.
Selecting properties for the Converter icon displays the Converter Properties dialog box described in the “File conversions” chapter.
Selecting properties for the Dispatcher icon displays the Dispatch Commands dialog box described in the “Accessing DOS files and
applications” chapter.
Selecting properties for the Scanners icon displays the User Application Setup dialog box, described in the “Peripheral devices” chapter.
Selecting properties for the Printers icon displays
the Print dialog box described in the "Local printers" appendix.
Print (<Ctrl>+<P>)
Sends one or more selected files to the default Windows printer and port. See the “Local printers” appendix for more information.
View
This option is similar to copying a file to the Viewer
icon and displays the selected file, if its extension links
with a display application. For example, you can associate the .PCX extension with the PaintBrush
application.
To make a file extension link to an application, use an
ASCII editor to edit the drive:\ELIXIR\ELX.INI file and
add the line extension=application to the file. For the
above example, you would add PCX= PBRUSH.EXE.
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Formats
Displays the File Formats dialog box that shows a list
of folders that contain different formats of a selected
file (files with the same stem name but different extensions). This feature is useful for checking or deleting
different formats of a file that may exist on your hard
disk.
Convert (<Ctrl> + <V>)
For one or more files selected in any Elixir folder
(Jobs, Forms, Fonts or Graphics), choosing this option displays a Converter dialog box that allows you to
specify the format to which you want to convert the selected file(s).
Alternatively, copy one or more selected files to the
Converter icon (see the “File conversions” chapter for
more information).
Transform
This option is not applicable to Elixir Forms Editor.
Dispatch (<Ctrl> + <I>)
With one or more files selected, opens the Dispatcher
Commands dialog box. See the “Accessing DOS files
and applications” chapter for more information.
Close (<F3>)
Closes an open window. Alternatively, click on the
close box on the window header.
Exit Elixir (<Alt> + <F4>)
Closes the Elixir Desktop and returns to Windows.
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System menu
The System menu allows you to configure the Elixir
Desktop. The “Desktop configuration” chapter describes all options in the System menu.

Figure C-3. System menu
System Config <Alt> + <F6>
Allows you to configure basic system parameters such
as warnings, logo displays, conversion parameters,
and double-click speed.
Usage Switches
Allows you to customize the Desktop by enabling and
disabling some options. Options include comfirmation
dialog boxes, property sheets, saving settings on exit,
converter selections, and when to stop processes.
User Privileges
Allows you to set the level of control over certain
Desktop operations for the user.
For example, you can choose whether or not to allow
a user to access an Elixir application from the Desktop. If you choose not to allow access, the icons representing the Elixir application and its associated
folder do not display.
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Diagnostics <Alt> + <F5>
Allows you to run a number of diagnostic utilities and
to enter a command to run a diagnostic program of
your choice.
Make Directory <Ctrl> + <M>
Allows you to create a DOS directory.
Converter Props
Allows you to specify certain initial setup options for
converting files and lets you modify control parameters for the Converter icon.
Reset to Defaults
Resets all configuration parameters to the default
values.
Refresh
Refreshes the screen display. You may want to use
this option if closing a window does not completely remove it or leaves “snow” on the screen.
Toolset
Allows you to switch between Desktop toolsets.

ELIXIR FORMS EDITOR DESKTOP USER GUIDE

C-7

THE ELIXIR DESTOP MENU BAR

Special menu
The Special menu contains the options shown in the
following figure.

Figure C-4. Special Menu
Close All (<F4>)
Closes all open windows on the Desktop.
Efont Factory
Displays the Contour Fonts folder window
(drive:\ELIXIR\FONTS\CONTOURS directory which, if
installed, initially contains 35 Bitstream Facelift contour font files.
The Elixir Efont Factory utility makes high-quality
screen and printer fonts for PostScript-compatible
printers from these contour fonts, and any other Bitstream Facelift-compatible contour fonts you install in
this directory. See the “File conversions” chapter for
more information about contour-to-raster font
conversion.
Install Fonts
Runs the Bitstream Loadtype program that installs Bitstream Facelift fonts on your PC. The program
prompts you to insert diskette #1 of your Bitstream
Facelift package into your diskette drive.
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Scheduler Setup (<Alt> + <F2>)
The Scheduler Desktop is a network-independent enhancement to the Desktop that automates file conversion and enables stand-alone “hands off” operation of
Elixir tools.
Scheduler Action (<Alt> + <F3>)
Allows you to define up to eight Scheduler actions
such as testing for a file in a given directory, checking
a date and time, or testing TRUE continuously for the
action specified.

DOS menu
The DOS menu allows you run to DOS commands
from the Desktop.
DOS Command (<Ctrl> + <D>)
Displays a dialog box allowing you to enter any standard DOS command.
Enter a DOS command and click on [OK] to clear the
Desktop and execute the command from the following
directories:
from the drive:\ELIXIR directory, if there are no
windows open on the Desktop
from the directory corresponding to the window, if
a window is open on the Desktop.
After execution, the program prompts you to press
any key to redisplay the Desktop.
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Window menu
The Window menu contains options for arranging the
display of open windows (and dialog boxes) on the
Elixir Desktop. It also contains an options for opening
a messge dialog box that displays current activities.
The bottom portion of the Window menu shows numbered entries allowing you to activate previously
opened windows and dialog boxes.

Figure C-5. Window menu
The Window menu contains the following options:
Cascade
You can arrange open windows so each header
shows and the active window displays in full on top of
the other windows.
Tile
You can resize and arrange windows side-by-side so
each window displays fully. The active window header
displays as highlighted.
Arrange Icons
This option arranges icons in an orderly manner within
the a window or on the Desktop.
Message
This option displays a message dialog box containing
information on current Desktop activity.
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Help menu
The Help menu contains Windows on-line help for the
Elixir Desktop. See the "Introduction" chapter for details.
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D.

Local printers

This section describes information required for printing form files on HP PCL or PostScript local proof
printers attached to your PC.
The local printer option uses the installed Windows
print drivers. To print a file, copy it to the Printers icon
on the Desktop (or select [Print] from the File menu,
or press <Ctrl> + <P>).
The Elixir Desktop supports local printing as follows:
You can print individual Elixir forms or a forms file
list (.DAT file) on any HP PCL printer connected
to your PC and configured in Windows.
When printing non-Elixir, non-ASCII forms you
can either specify a binary copy operation to the
printer port or specify a user-defined print driver.
You can print ASCII text files or formatted data
streams if the proof printer connected to your PC
can correctly interpret the files or data streams.

Printing an Elixir form
You can add, change, or delete printer drivers (for
printing Elixir forms) from the Print dialog box in Windows Control Panel. You can also access the Windows Print dialog box from the Desktop by
right-clicking on the Printers icon.
You can also change the current printer's setup by
displaying the Printers icon properties.
The following example shows the Print properties dialog box for Windows.
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Figure D-1. Print dialog box
Printer
The default printer displays as a HP LaserJet IID connected to the LPT1: port.
Orientation
The orientation of the printed page: [Landscape] or
[Portrait].
Page Shift
The number of dots you want the printed page shifted
to the right (X-shift) or down (Y-shift). Negative values
are permissible.
Copies
The number of copies of the printed page.
Print to File
Creates a HP PCL print file instead of printing.
Message
Displays the following dialog box:
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Figure D-2. Message Options dialog box
[Show messages after process]
Displays any error messages after printing.
[Write Messages to LOG file]
After printing, writes error messages to the LOG file
you specify. If you select this option, you can also
specify that messages [Appended to LOGfile] or
[Overwrite LOGfile].
Setup
Allows you to specify (Windows) setup parameters for
your printer.

Printing a non-Elixir form
When printing non-Elixir forms from the Output or Input Forms folders, the Printer Setup dialog box
displays.

Figure D-3. Printer Setup dialog box

ELIXIR FORMS EDITOR DESKTOP USER GUIDE

D-3

LOCAL PRINTERS

Printer Selection
[Copy to printer on Port] performs a binary copy operation to the selected port.
[User-Defined Print Driver] allows you to specify a
user-defined print driver. Click on Setup for specifying the driver.
Port
Allows you to specify the port as [LPT1], [LPT2], or
[LPT3].
Copies to Print
The number of copies you want printed.

Creating a .DAT file for proof-printing
A .DAT file can contain multiple .ELX files and allows
you to categorize your Elixir-format forms into one file
for a proof-print run, rather than printing each .ELX file
separately.
You can also view and edit the .DAT file to ensure
proper sequencing of the .ELX files for your print run.
You can create a .DAT file in two ways:
create and name a new file with the Elixir Documents folder open
drag and drop the .ELX file(s) from the Elixir
Forms folder onto an empty space in the Elixir
Documents folder.
Creating a new .DAT file in the Elixir Documents folder
To create a .DAT file in the Elixir Documents folder:
1.

Open the Documents folder, and the Elixir
Documents folder.

2.

From the File menu, select [New].
The File Name Entry dialog box displays.
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Figure D-4. File Name Entry dialog box
3.

Enter a file name in the [Selecting File(s)]
option and click on [OK].

You can now copy the .ELX files into the .DAT file
Copying the .ELX files to the Elixr Documents folder
To create a .DAT file from the Elixir Forms folder:
1.

Open the Forms folder, and the Elixir Forms
folder.

2.

Select and drag
Documents folder.

the

.ELX

files

to

the

Your cursor becomes a multi-page pointer.
3.

Click on the Elixir Documents folder then click
on any empty space in the file folder.
The File Name Entry dialog box displays.

Figure D-5. File Name Entry dialog box
4.

Enter a file name in the [Selecting File(s)]
option and click on [OK].
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Although the screen returns to the Elixir Forms folder,
the new .DAT file now resides in the Elixir Documents
folder.
Viewing and editing a .DAT file
You may want to view and edit a .DAT file to ensure
all the .ELX files are present and sequenced according to the order you want them to print.
To view the .DAT file, double-click on the file.
The ASCII-based Windows Notepad dialog box opens
displaying the contents of the .DAT file. You can now
edit the file.
If you want to add .ELX files, repeat the steps
provided in "Copying the .ELX files to the Elixr
Documents folder", but instead of dropping the
files onto an empty space, drop them onto the
.DAT file.
If you want to edit or sequence the .ELX files, use
the editing (cut, copy, paste, etc.) options in the
Notepad Edit menu.
Proof-printing a .DAT file
To proof-print a .DAT file, copy it to the Printers icon
on the Desktop (or select [Print] from the File menu,
or press <Ctrl> + <P>).
Note: Depending on the products installed on your
Desktop, DataMerge options may display. See your
DataMerge manual for detailed information.
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Glossary

This glossary contains a basic list of the terminology
used in this guide.
application
Any program you run on your PC. Icons represent
Elixir applications on the Elixir Desktop. If you did not
install an Elixir application on your PC, its icon does
not display.
arrow
The screen pointer used for selecting objects.
button
An area on the screen that responds when you click
on it. For example, each dialog box has an [OK] button that accepts your entries when you click on it.
click, on an item
To momentarily press and release the left mouse button with the screen pointer on an item.
close
To exit from a window, dialog box, or the Desktop.
close box
A small white box at the left of a window header and
at the left of the menu bar. Clicking a close box on a
window header closes the window. Clicking a close
box on the menu bar exits the Desktop.
command button
A button in a dialog box that confirms or cancels an
action when you click on it. The [Cancel] button cancels the command. The [OK] button confirms and
executes the command and saves the information you
specified in a dialog box.
Converter icon
The icon that converts font, form, graphics, and document files.
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cursor
An I-shaped screen pointer used when entering text in
a dialog box.
Desktop
The Elixir Desktop working environment, consisting of
the menu bar, the screen area, and the icons on the
screen.
dialog box
A rectangular box that displays and requests information. You enter information in fields in the dialog box,
and normally confirm your entries by clicking on an
[OK] button or by pressing <Enter>.
dimmed options
Dimmed options are menu options you cannot choose
because they do not apply to your current selection.
Also called grayed options.
directory
A list of hard disk or diskette contents. Folder icons
represent Desktop directories. You can view folder
contents pictorially, alphabetically, by icon, by size, or
by date.
Dispatcher icon
The icon that stores and invokes a number of DOS
commands.
DOS
Disk Operating System, the collection of programs
that gives control of a PC's resources to the user.
double-click
To press the left mouse button twice in rapid
succession.
drag
To click on an item and move the item with the mouse
while holding down the left mouse button.
drag and drop
Used to copy an object as follows: click on an item on
the screen, hold down the left mouse button, move the
mouse to move the screen pointer to an icon, and release the mouse button.
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drop
To release the mouse button after dragging an item to
an icon.
Elixir folders
The folders represented by the four top left icons on
the Desktop: the Forms, Fonts, Graphics, and Documents folders. Each of these folders contains an
Elixir, Input, and Output folder. See the “Folders and
directories,” chapter for information about DOS subdirectories that correspond to the above folders.
extension
The three characters following the period after a file
name. In the Desktop, an extension identifies the type
of information in a file. For example, .ELX indicates
an Elixir format form file.
fast keys
See the "Keyboard shortcuts" appendix.
file name
The name of a file. The Elixir Desktop uses DOS file
naming conventions. DOS file names consist of a
base (stem) name containing up to eight characters
and an extension of up to three characters.
folder icon
The Desktop icon representing a DOS directory.
Folders allow you to quickly organize information on
the Desktop.
form font list
An ASCII .LST file in the default ElixiForm screen
fonts directory. This file lists up to 24 screen font
stem names which you can b use to create an Elixir
form.
form list file
A form list (.DAT) is an ASCII file that contains a list of
Elixir form file names (.ELX files) and commands that
control how specific forms print.
format
To prepare a diskette so it can hold information. Formatting a diskette erases the information on the diskette.
The Elixir Desktop allows you to format
Xerox-format diskettes.
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generic Elixir format
The DOS file format an Elixir application uses (such
as ElixiFont, ElixiGraphics, and ElixiForm).
highlighted
A highlighted icon indicates a selected icon.
icon
A small symbol on the Desktop that represents an application, a file, a folder, or a peripheral device.
importing files
The process of copying non-Elixir format files from different storage media (such as the hard disk, a diskette, or tape) to the appropriate Desktop input folder.

Inverse Landscape

Landscape

Landscape
Portrait

Inverse Landscape

Portrait

Inverse Portrait

inverse landscape/portrait
The orientation of fonts, logos, or images on a page.
See the definition for portrait for a figure describing
the orientation of fonts on pages. See figure G-1.

Inverse Portrait
Figure G-1. Orientation of fonts on a Portrait (left)
and a Landscape (right) page
invoke
To start an application. Also referred to as run .
kerning
The technique of changing the printed space between
characters from the normal spacing. Overlapping
characters create the effect.
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keyboard shortcut
Also called a Fast Key. A one- or two-key combination that allows you to execute an option without using
the mouse. Keyboard shortcuts display on each
menu beside the name of the option (see the “Keyboard shortcuts” appendix).
landscape
The orientation of a page or the fonts, logos, or images on a page. A landscape page is narrower on the
sides than on the top. See figure G-1.
menu
A list of options from which you make a selection to
perform an action. A menu displays when you select
a menu title from the menu bar or from a window
header.
menu bar
The horizontal bar displayed at the top of the Desktop
from which you access pull-down menus.
menu titles
Text that identifies a menu, displayed in a window
header or on the menu bar.
message area
A bar just below the menu bar that displays error messages or information about the activity you are
performing.
mouse button
A button on top of the mouse. The Elixir Desktop supports most actions using the left mouse button. Use
the right button to display icon properties and Help.
multi-select
Selecting more than one file or icon by shift-clicking
on them.
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open a folder, Elixir file, application, or peripheral
device:
1.) Opening a folder icon displays a window showing
the contents of the folder. 2.) Opening an Elixir file
icon starts the application that created the file and
loads the file . 3.) Opening an application icon starts
the application. 4.) Opening a peripheral device displays a properties dialog box allowing you to set the
device parameters.
option
A word or phrase in a menu that you can select.
peripheral (device)
A printer, scanner, or diskette drive connected to your
PC.
point
To move the mouse so the screen pointer (in most
cases an arrow) rests on the desired item.
portrait
The orientation of a page or the fonts, logos, or images on a page. A portrait page is narrower on top
than on the side (like pages in this book). See figure
G-1.
Printers icon
The icon representing a proof printer connected to
your PC.
pull-down menu
See menu.
raster graphics
Pictures composed of bit maps, where each element
of the picture is a dot defined as black or white.
replaceable parameter
A parameter (usually %1) used in DOS commands to
represent a selected file name. The selected file
name replaces the parameter during certain
operations.
run
To execute or start an application. Also referred to as
invoke.
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Scanners icon
The icon representing a scanner connected to your
PC.
screen pointer
A pointer shaped like an arrow that displays on the
screen, and which you can move by rolling the mouse
on a flat surface.
scroll
To move a directory list in a window so you can view
different parts of the list.
scroll bar
A bar displayed on the right side of some windows
used for scrolling. The scroll bar contains a scroll arrow, + and - buttons, and a slider bar that moves
within the scroll box.
select
To click on an object or menu option. A selected item
appears highlighted.
shift-click
To click on an object while holding down the <Shift>
key. Usually used to select multiple items.
slider bar
A bar in the scroll box at the side of some windows
that scrolls items in the window when you drag it up
and down.
Trashbin icon
The Trashbin icon is in the lower right corner of the
Desktop and represents a receptacle for items you
want to delete. You delete a file by dragging it to the
Trashbin icon.
unselect
To cause one or more selected (highlighted) icons to
not be selected any more. The quickest way to do this
is to click on another area of the Desktop.
User Files icon
The icon that links applications to files.
User Tools icon
The icon that allows you to create and define icons for
DOS applications and batch files.
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utilities
Special-purpose applications with which you can perform functions from the DOS prompt. For example,
the ELIXIDISK utility allows you to read, write, and format Xerox printer format diskettes.
wildcard character
A character in a file name, usually an asterisk (*), that
specifies a matching set. For example, *.FNT represents all files that end with the .FNT extension.
window
A rectangular area on your screen in which you view
information, such the contents of a folder. All windows contain a window header. Some windows have
scroll bars along the right side.
window header
The top of a window that displays the DOS directory
corresponding to the window contents. Some window
headers also show a close box and a number of menu
titles with pull-down menus
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A
access alternatives, 4-7
application icons
ElixirForm, 2-4
applications icons
creating, 8-2
opening, 5-3
Arguments to this Program, 8-11
AUTOEXEC.BAT, 4-10,
8-2, 8-18

B
backup button, 2-6, 8-9
batch files, 8-12
Bitstream Facelift fonts,
7-25, B-2
Bitstream Fontware,
7-25
BTFONTS.MAP, B-2
BTFONTS.NAM, B-2

C
cautions, 1-8
Clipboard, 2-3
COMMAND.COM, 8-12,
8-13
CONFIG.SYS, 4-10, 8-2
configuration options,
4-2
confirm/warn settings,
4-4, 7-7
contour fonts, 7-25, B-2
conventions
display, 1-3
font naming, 7-29
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typographical, 1-3
Converter
icon, 2-5, 7-2
overview, 2-5
properties, 4-5,
4-11, 7-5
setup, 7-5
Converter icon, 5-4
converting
fonts, 7-4, 7-23
forms, 7-3, 7-9,
7-16, 7-20, 7-22
forms to graphics,
7-15
general, 7-2
graphics, 7-33
graphics to tiles in a
font, 7-34
HP PCL, 7-10
HP PCL fonts, 7-24
outline fonts, 7-25
PDF, 7-16
PostScript, 7-12
procedures, 7-8
setup parameters,
7-5
XGF, 7-20
XSOP, 7-22
copying files, 5-8, 8-9
creating
a .DAT file, D-4
a .PUB file, 5-15
customer support, 1-2
customer training, 1-2
customizing the Desktop, 4-1, 4-4
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D
Data Jobs
Elixir folders, 3-16
Desktop
archival feature,
5-15
basic setup, 4-3
basics, 2-1
cautions, 1-8
Clipboard, 2-3
customizing, 4-1,
4-4
DOS menu, 2-11,
8-21, C-9
exiting, 1-8, 2-12
features, additional,
5-1
File menu, 5-1, C-1
folders, 2-3, 3-1
Help, 1-4
Help menu, 1-4,
C-11
icons, 2-2
keyboard shortcuts,
A-1
layout, 2-1
menu bar, 2-1, 4-1,
5-1, C-1
message area, 2-1
resetting, 4-12
Scheduler Desktop,
5-19
Special menu, 4-1,
5-1, C-8
starting, 1-7
system configuration, 4-2
System menu, 4-1,
5-1, C-6
toolsets, 4-13
usage switches, 4-4
user privileges, 4-7
Window menu, C-10
diagnostics, 4-2, 4-9
directories
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accessing, 8-7
Bitstream Facelift
mapping, B-2
changing, 8-9
contour fonts mapping, B-2
creating, 4-10
DOS, 5-10
PostScript mapping,
B-1
screen fonts, 7-14
structure, 3-1
User Files, 5-10, 8-7
working, 7-6
diskette
accessing, 6-1
DOS format, 5-12,
5-14, 6-2
properties, 4-5
system, 5-12, 6-2
Diskette icon, 2-4, 5-3,
5-12, 6-1
DISP utility, 9-2
Dispatcher, example,
8-18
Dispatcher icon, 2-5,
5-4, 8-1, 8-13
display options, files,
2-10
Docs Jobs
Elixir folders, 3-15
documents
Elixir Documents
folder, 3-13
folders, 3-13
Input Documents
folder, 3-14
Output Documents
folder, 3-14
Documents folder, 2-3,
3-13, 7-4
DOS
access, 2-11, 4-9,
8-1, 8-7, C-9
batch files, 8-12
commands, 8-14,
8-21, C-9
copying files, 5-10
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directories, 3-1,
5-10, 8-7
diskette, 5-11, 5-12,
6-2
executables, 8-12
folders and directories, 3-1
linking files, 5-4
menu, 2-11, 8-21,
C-9
storing commands,
8-13
DOS menu, 8-21, C-9
double-click speed, 4-4

E
Efont Factory, 7-25,
7-29, 9-7
ElixiKey, 4-10
Elixir file formats, display, 5-6
Elixir folders
Data Jobs, 3-16
Docs Jobs, 3-15
Documents, 3-13
Fonts, 3-8
Forms, 3-5
Graphics, 3-11
structure, 3-2
Elixir Image Viewer,
5-28
ElixirForm icon, 2-4
opening, 5-3
ElixiScript Converter
Properties, 7-13
ELXINV utilty, 9-3
ELXWDATA utility, 9-5
error messages, D-3
exiting the Desktop, 1-8,
2-12
Extra Converter Options,
7-35

F
fast keys, A-1
File menu, 5-1, C-1
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File Object Properties,
7-1
files
.BAK, 3-5
.BAT, 8-12
.COM, 8-12, 8-13,
9-1
.DAT, D-4
.ELX, 7-3, 7-4, 7-9,
D-5
.EXE, 9-1
.HDR, 7-4
.INV, 3-5
.LP3, 7-4, 7-9, 7-15,
7-35
.PCX, 5-26
.PUB, 3-5, 5-15
.SYS, 8-2
.TDF, 7-31, B-2
.TFB, 7-28, B-2
.TXT, 7-35
access alternatives,
4-8
AUTOEXEC.BAT,
4-10, 8-2, 8-18
batch (.BAT), 8-12
BTFONTS.MAP,
B-2
BTFONTS.NAM,
B-2
COMMAND.COM,
8-12
CONFIG.SYS, 4-10,
8-2
confirm/warn settings, 4-4
conversion process,
7-8
converting, 7-1
copying, 5-8, 8-9
deleting, 4-4
display options, 2-10
editing, 3-4
graphics, 5-27
INSTALL.LOG,
4-10, 8-2
linked, 8-11
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linking, 5-4, 8-10
management, 5-6
overwriting, 4-5
properties, 5-5, 7-1
PSEND.PSC, B-1
PSFONT.MAP,
7-13, 7-22, 7-28, B-1
PSTOP.PSC, B-1
PSTRAIL.PSC, B-2
versions, 5-6
files, viewing, 5-26
Filter menu, 2-7
folders
copying files, 5-14
Desktop, 3-1
Documents, 3-13,
7-4
Elixir, 3-2, 3-3, 5-2,
7-3
Elixir Data Jobs
folder, 3-16
Elixir Docs Jobs
folder, 3-15
Elixir Documents
folder, 3-13
Elixir Fonts folder,
3-8
Elixir Forms folder,
3-5
Elixir Graphics
folder, 3-11
Elixir Jobs folder,
3-15
Fonts, 2-3, 3-7, 7-4
Forms, 2-3, 3-5, 7-3,
7-9
Graphics, 2-3, 3-10,
7-4
Input, 3-3
Input Documents
folder, 3-14
Input Fonts folder,
3-8
Input Forms folder,
3-6
Input Graphics
folder, 3-11
INDEX-4

Jobs, 7-5
Output, 3-4
Output Documents
folder, 3-14
Output Fonts folder,
3-9
Output Forms folder,
3-6
Output Graphics
folder, 3-12
structure, 3-2
User Files, 2-4
font mapping, 7-13, 7-22
FONTCHG utility, 9-5
FONTMAP utility, 9-7
fonts
adding HP PCL
fonts to a Windows
application, 7-32
Bitstream Facelift,
7-25, B-2
Bitstream Fontware,
7-25
BTFONTS.MAP,
B-2
BTFONTS.NAM,
B-2
contour, 7-25, B-2
converter options,
7-23
converting, 7-23
Efont Factory, 7-25
Elixir fonts folder,
3-8
generating Elixir
fonts, 7-31
generating non-Elixir
fonts, 7-32
HP PCL, 7-24
Input Fonts folder,
3-8
kerning, 7-28
mapping, 7-13,
7-22, 7-27
name, 7-27
naming conventions,
7-29
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orientation, 7-28
outline, 7-25
Output Fonts folder,
3-9
PSFONT.MAP,
7-13, 7-22, 7-28, B-1
PSSEND.PSC, B-1
PSTOP.PSC, B-1
PSTRAIL.PSC, B-2
screen, 7-32
Fonts folder, 2-3, 3-7,
7-4
Form Converter Options,
7-9
FORMPRN Properties,
7-10
FORMPRN utility, 9-8
forms
converting, 7-9
converting to graphics, 7-15
Elixir Forms folder,
3-5
Input Forms folder,
3-6
orientation, 7-10,
7-11
Output Forms folder,
3-6
PDF, 7-16
XGF, 7-20
XSOP, 7-22
Forms folder, 2-3, 3-5,
7-3, 7-9
FSIMG utility, 9-10

G
Graphic Converter Options, 7-36
graphics
.BMP conversions,
7-37
.PCX and .TIF conversions, 7-35
converting, 7-33
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converting to tiles in
a font, 7-34
Elixir Graphics
folder, 3-11
Elixir Image Viewer,
5-28
Highlight Color option, 7-36
Input Graphics
folder, 3-11
Output Graphics
folder, 3-12
restrictions and limitations, 7-37
tiles, 7-34
Graphics folder, 2-3,
3-10, 7-4

H
Help, on-line, 1-4
Help menu, 1-4, C-11
Highlight Color option,
7-36
HP Font Converter Options, 7-24
HPEDIT utility, 9-12

I
IC utility, 9-13
icons
applications, 8-2
checking properties,
8-6
Clipboard, 2-3
Converter, 2-5, 7-2
create (example),
8-5
Desktop, 2-2
Diskette, 2-4, 5-3,
6-1
Dispatcher, 2-5, 8-1,
8-13
Documents, 2-3, 7-4
ElixirForm, 2-4
folders, 2-3
INDEX-5

INDEX

Fonts, 2-3, 7-4
Forms, 2-3, 7-3, 7-9
Graphics, 2-3, 7-4
Jobs, 2-3, 7-5
modifying, 5-5
opening, 5-1, 5-3
Other Elixir applications, 2-4
Printers, 2-5, 5-3,
D-1
properties, 5-5
Scanners, 2-5, 5-3,
6-3
Trashbin, 2-5
User Files, 2-4, 3-2,
5-9, 8-1, 8-7
User Tools, 2-4, 8-1,
8-2
Ventura Publisher,
8-5
Viewer, 2-6, 5-26
Image Converter Options, 7-16, 7-34
Image Viewer, 5-28
Input Contours folder
window, 7-26
Input folders
Documents, 3-14
Fonts, 3-8
Forms, 3-6
Graphics, 3-11
structure, 3-3
INSTALL.LOG, 4-10, 8-2

J
jobs
Jobs, 3-15
Jobs folder, 2-3, 3-15,
7-5

K
kerning, 7-28
keyboard mapping, 7-19
keyboard shortcuts, A-1
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L
linked files, 8-11
linking files, 8-10
local proof printer, D-1
logo, display, 5-7
LP32ELX utility, 9-14

M
mapping, 7-13, 7-22,
7-27, B-1
mapping table
Bitstream Facelift
fonts, B-2
contour fonts, B-2
directories, B-1
PostScript, 7-13, B-1
memory, 4-9
menu
Special, 4-1
System, 4-1, 4-11
menus
Desktop, 5-1, C-1
Desktop menu bar,
2-1
DOS, 2-11, 8-21,
C-9
File, 5-1, C-1
Filter, 2-7
Help, 1-4, C-11
options, C-1
Selection, 2-8
Special, 5-1, C-8
System, 5-1, 8-20,
C-6
Tools, 8-2, 8-10
View, 2-9
Window, C-10
message area, 2-1
message reporting,
4-12, 7-7, D-3
monochrome monitor
setup, 4-5
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N
Notepad, 5-27, D-6

O
on-line Help, 1-4
other Elixir application
icons, 2-4
Outline-to-raster font
generator, 7-26
Output folders
Fonts, 3-9
Forms, 3-6
Graphics, 3-12
structure, 3-4

P
PaintBrush, 5-26
PDF Settings, 7-17
peripheral devices, 6-1
PostScript mapping table, B-1
Print Driver Dialog, 7-14
printer-specific
print drivers, 4-7
Printers icon, 2-5,
5-3
printing a .DAT file,
D-6
printing a non-Elixir
form, D-3
printing an Elixir
form, D-1
proof-printing, D-1
properties, 4-5
Printers icon, 2-5, 5-3,
D-1
properties
Converter, 4-5, 4-11,
7-5
diskette, 4-5
displaying icon, 8-5
file, 5-5, 7-1
icons, 5-5, 8-5
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printer, 4-5
scanner, 4-5, 6-3
tool, 8-11
user application, 6-3
PSEND.PSC, B-1
PSFONT.MAP, 7-13,
7-22, 7-28, B-1
PSSTASH, B-1
PSTOP.PSC, B-1
PSTRAIL.PSC, B-2
PUB files, 5-16
copying, 5-17
creating, 5-15
restoring from diskette, 5-18

R
refreshing screen, 4-13
restrictions, graphics,
7-37

S
scanner
properties, 4-5
Scanners icon, 2-5, 5-3,
6-3
Scheduler Desktop
actions/tasks, 5-21
setup, 5-20
testing examples,
5-24
use, 5-19
screen, refreshing, 4-13
screen fonts, 7-32
Selection menu, 2-8
shortcuts, keyboard, A-1
SHOWBLOK utility, 9-15
SHOWELX utility, 9-16
Special menu, 4-1, 5-1,
C-8
stand-alone utilities, 9-1
starting the Desktop, 1-7
sub-window, 2-6
support, customer, 1-2
SYSTEM.INI file, 2-6
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system configuration,
4-2
system diskette, 5-13,
6-2
System menu, 4-1, 5-1,
8-20, C-6

FSIMG, 9-10
HPEDIT, 9-12
IC, 9-13
LP32ELX, 9-14
running, 8-20
SHOWBLOK, 9-15
SHOWELX, 9-16
stand-alone, 9-1
using, 9-1
using the Dispatcher, 8-20

T
tool properties, 8-11
Tools menu, 8-10, 8-11
toolsets, 4-13
training, customer, 1-2
Trashbin icon, 2-5

U
usage switches, 4-4
User Application Setup,
8-3, 8-15
User Files
directories, 8-7
tool links, 5-10, 8-7
User Files icon, 2-4, 3-2,
5-4, 5-9, 8-1, 8-7
user privileges, 4-7
User Tools
creating application
icons, 8-2
displaying icon properties, 8-5
example, 8-5
starting an application, 8-5
Tool Linkage dialog,
8-10
User Tools icon, 2-4,
5-4, 8-1, 8-2
utilities
DISP, 9-2
displaying, 9-1
Efont Factory, 7-25,
9-7
ELXINV, 9-3
ELXWDATA, 9-5
FONTCHG, 9-5
FONTMAP, 9-7
FORMPRN, 9-8
INDEX-8

V
Ventura Publisher
creating an icon, 8-5
from the Desktop,
8-5
View menu, 2-9
Viewer icon, 2-6, 5-4,
5-26
viewing and editing the
.DAT file, D-6

W
Window menu, C-10
Windows
adding HP PCL
fonts, 7-32
and the Desktop,
2-1
keyboard shortcuts,
A-2
Notepad, 5-27, D-6
operating system,
2-1
PaintBrush, 5-26
print driver, 7-7

X
XGF Settings, 7-20
XSOP Converter Properties, 7-22

ELIXIR TECHNOLOGIES CORPORATION

